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1.  Overview
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1. Overview
1.1. Overview - Database

When you acquire a large number of imageswith your software, it makes sense to
save them in a database. All of the file management functions, such as searching for
images, can bemore quickly and easily used in a database than with files that have
been saved separately.

Your software offers a client server database for this purpose. Your software's
database doesn't only save images, it also saves all other types of file, for example,
text files or sheets.

1.1.1. Which software version supports which database?
The database functionality is available in all versions of your software except
OLYMPUS StreamStart. There are different software packages for the database.

Stream Document Storage
By default, the software versionsOLYMPUS StreamBasic,OLYMPUS Stream
Essential, andOLYMPUS StreamMotion include the SolutionStreamDocument
Storage. StreamDocument Storage offers some basic database functions. You can,
for example, define database fields.

Workgroup Database
TheWorkgroup Database solution is available as a solution for the following software
versions:OLYMPUS StreamBasic,OLYMPUS StreamEssentials, andOLYMPUS
StreamMotion. TheWorkgroup Database solution will replace theStreamDocument
Storage database version.

TheWorkgroup Database database version supports the following database
management systems:

l Microsoft SQL Server 2017 Express
l Microsoft SQL Server 2016 Express
l Microsoft SQL Server 2014 Express
l Microsoft SQL Server 2012 Express
Microsoft SQL Server 2008 R2 Express

Enterprise Database
TheOlympusStreamEnterprise software version contains theEnterprise Database
database version. TheEnterprise Database solution is also available for the software
versionOLYMPUS StreamBasic andOLYMPUS StreamEssentials.

TheEnterprise Database containsmore functionality in comparison to theWorkgroup
Database version.
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The following databasemanagement systems are additionally supported:

l Microsoft SQL Server 2017
l Microsoft SQL Server 2016
Microsoft SQL Server 2014

l Microsoft SQL Server 2012
l Microsoft SQL Server 2008 R2
l Oracle 12
l Oracle 11g R2

1.1.2. Database manual
Prerequisite: The databasemanual is only available for theWorkgroup database and
the Enterprise database. TheDocument Storage solution is described in the online
help.

How is the structure of the database manual?
The documentation is for database users aswell as for database administrators. Since
database administrators havemore rights to work with the database, not all of the
topics covered in thismanual are equally relevant for all database users.

Topics for database users
The topics about the user interface and the topics about working with the database are
for all database users. Therefore, it is assumed as a precondition that a database has
already been set up and configured.

Topics for database administrators
The topics about configuring the database are only for the database administrator.

00062 25022021

1.2. Overview - Database functions

Saving documents in a database
You can insert not only images, but also documents which have another file format into
a database. That enables you to store all manner of data that belongs together in one
location. Search and filter functionsmake it quick and easy to locate documents.

Imageswill, by default, be saved in the TIF or VSI file format. When you save an
acquired image in TIF format, a lot of important image information will be automatically
saved with it, for example, data concerning the camera used, the exposure time, the
resolution, the time of creation, and so on. This data is automatically entered in
predefined database fields. You do not need to collect this data separately.

OLYMPUS Stream Database User Manual 5
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The database's user interface
The database will be displayed in theDatabase tool window. This tool window gives
you access to all of the records that are in the database.

The layout of your database user interface is based on the tasks you want to
undertake with your database. In theDatabase tool window, you can choose between
different main views. In every view, the tool window for another task is optimized. All
database views can be configured.

File storage in your database
The database supports two different document storage types for images and other
documents: File System andSecure File Repository (only for the "Database
Enterprise Edition").

Where the document storage in a file system is concerned, images and other
documents will be saved in special document directories. When the Secure File
Repository storage type is used, images and other documents are located on a server
that has been set up for this purpose as a Secure File Repository (SFR).

User rights for your database
The database is designed tomake it possible for numerous users to use your
database in a network simultaneously. Each user has his own user profile which
allows him to see, e.g., his own search definitions and database views.

If you are a database administrator, you can define user rights for your databases. The
user rights determine the database functions each user canmake use of.

Using databases in an Intranet and in the Internet
The database is a client server database. Numerous users can, therefore,
simultaneouslymake use of the database from numerous PCs.

Should a user have the right to, he can use all of the databases that are onMicrosoft
SQL servers ("Olympus StreamMotion" and "Olympus StreamEnterprise") or on
Oracle servers (only "Olympus StreamEnterprise"). The databases are normally
integrated in a closed network (Intranet).

You can also release databases for use in the Internet. Then you can view the images
and the data from every Internet browser.

Linking up with other databases (only for OLYMPUS Stream
Enterprise)
You can open databases that were set up with the Olympus software, analySIS or
aquinto a4i Docu, on aMicrosoft SQL server or anOracle server. You don't need to
convert the databases into the Olympus Stream database format to do this. The
databaseswill be opened write protected, and can't be changed. It is, however,
possible to search for documents and to load them.

You can also link up with external databases. This enables you, when setting up a new
record, to automatically adopt information from another database, or inversely to
transfer data from your software to the external database. In this way, you avoid the
necessity of taking care of the same data stock in different databases.
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Exporting data
You can export individual documents from a database. In this way, you can, e.g., make
images available to users who have no access to the database.When you export a
document, youmake a copy of it. Thismeans that the original documents in the
database will be retained.

00233 25022021
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2. User Interface
2.1. Tool Window - Database

The database will be displayed in theDatabase tool window. This tool window
provides you with access to all of the records contained in the database, and to
numerous functions you can use to work with your database.

Should theDatabase tool window be hidden, use theView > ToolWindows >
Database command tomake it appear.

Main views in the database window
In theDatabase tool window, you can choose between different main views. The tool
window is differently divided up in every view, and also displays different information.

Use the first buttons  on theDatabase tool window's lower toolbar to
toggle between themain views. The button for the active view will appear clicked. You
can recognize this status by the button's colored background.

The illustration shows the schematic structure of theDatabase tool window in the
variousmain views (1 = Project View, 2 = Document View, 3 = Search Results View).

(1) Project View: In the Project View, you set up new projects or edit already existing
ones. There, you select the project that you can view and work on in the Document
View.

(2) Document View: In the Document View, you insert new samples and documents
into a specific project. There, you can view, work on, or load, already existing
documents.
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(3) Search Results View: In the Search Results View, the results of a database search
are displayed.

Toolbars in the database window
TheDatabase tool window contains two toolbars. These toolbars provide you with
access to themost important functionswhen you're working with a database.

Insert Record Click this button to insert a new record in the current
database.

Insert Open
Documents

Use this command to insert documents into the database
that have already been opened in your software.

Insert From Files Use this command to insert documents into the database
that have already been saved as a file on a datamedium.

Load Documents Use this command to load all selected documents from a
database to your software.

Confirm Changes

Abort Changes
Click this button to confirm or abort changes made to an
existing record.

Delete Record Use this command to delete all of the selected records from
the database.

Recycle Bin
Click this button to see all records available in the
database's recycle bin. You can restore or permanently
delete records.

OLYMPUS Stream Database User Manual 9
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Show Projects Click this button to switch to the Project
View.

Show
Documents

Click this button to switch to the
Document View.

Show Search
Results

Click this button to switch to the Search
Results View.

Define Filter Use this command to define a data filter.

Remove Filter Use this command to remove the active
data filter.

Define Search Use this command to define search
conditions for a database search.

Show/Hide
Search or Filter
View

Click this button to show or hide the
Search View or the Filter View.

Find Text in
Database

You can search for text directly in your
database without first having to define a
search definition.

Maximizing the database window
TheDatabasewindow can, as the only tool window, bemaximized. To do this, click
theMaximize button. You can find this button in the tool window's header. This will
make almost the whole of your software's user interface available for displaying the
database.

Empty database window

Commands in an empty database window
When no database has been opened, theDatabase tool window offers you the
commandswith which you can open a database, or set up a new database.
There, you can also find a list of the databases that were last opened. Simply click an
entry to open the corresponding database.

00273 28062017
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2.2. Layout - Database
When you work with the database you switch to theDatabase layout.

Distinctive features of the "Database" layout
l Only in this layout is theDatabase tool window maximized by default. Maximizing
the tool window has the advantage that you have a clearer overview of the
database's recordswhich helps you to use all of the functions for searching,
grouping, or editing records optimally.

l Only in this layout will the document group not be displayed, since, as a rule, you
won't need the document group when you are working with a database.

l In theDatabase layout, only those of your software's commands are available that
you require when you are working with a database. Commands that are not
available will be shown in gray. Should you want to use one of the commands
shown in gray, simply switch to another layout.

Which elements of the user interface are displayed?
In theDatabase layout, you will be offered the following toolbars and tool windows by
default.

(1) Tool windows
TheDatabase tool window ismaximized and therefore fills out your software's
complete document group. This tool window provides you with access to all of the
records contained in the database, and to numerous functions you can use to work
with your database.

(2) Toolbars
At the very top of the user interface, below themenu bar, several toolbars are on
display. Use, e.g., theCamera Control toolbar to acquire imageswhile you are
working with your database.

Note: Some buttons on the toolbars that are on display will not be available as long as
theDatabase tool window has beenmaximized.
For example, theCamera Control toolbar's buttons are only active, when you are in
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your database's Document View. Since only there can you see the live-image and
insert images.

00023

2.3. Project View of the database
In theDatabase tool window, you can choose between different main views. The
Project View is used to display the records on the topmost database level. When you
adopt the predefined database structure, these are "Projects". It is, however, not
essential that records on the topmost database level are called "Projects". Depending
on the way your laboratory is organized, you can also set up a database in which, for
example, "Orders" are on the topmost database level.

Structure of the tool window in the Project View
TheDatabase tool window is divided into several areas. In each of these areas, a
special database view is displayed. You can change the size of individual areas, by
dragging the area boundary with your mouse button depressed.

The illustration shows the schematic construction of theDatabase tool window in the
Project View.
The Project View contains two toolbars (1) with themost important functions you'll
need when working with a database.
The tool window is divided up into the areas Project List View (2) and Project Info View
(3). Aswell as that, you can also filter the projects in the Project Filter View (4) and by
doing this, limit the number of projects on display.

Database views within the Project View

Each database view within the Project View shows different information and allows
different actions.

OLYMPUS Stream Database User Manual 12
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Switching to the Project View
Click theShow Projects button to switch to the Project View. You can find this button
on theDatabase tool window's lower toolbar.
In the Project View this button appears clicked. You can recognize this status by the
button's colored background.

Activities in the Project View
The following actions are possible in the Project View.

1. You set up a new project in the Project View. To do so, use theDatabase > Insert
> Project... command.

2. Look for the project that you want to edit.
3. Filter your project list so that only the projects that currently interest you are

displayed.
4. You can gain information on a project in the Project Info View. You can also

change the entries for a project there.
5. Select the project that you can work on in the Document View. To do this, double

click on the project.
00028

2.3.1. Project List View
In the Project List View, you can see the project folders that have already been
inserted into the database. You will find this database view in your database's Project
View.

The illustration shows the schematic construction of theDatabase tool window in the
Project View.
You can find the project list (1) at the bottom left of the tool window.

Information in the project list

Project list
The project list shows all of the projects that are present in the database.

Information on the projects
The project list is organized as a table. The project list shows numerous database
fields for each project. In every column, you can find the corresponding entries for
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every project in the database field.

How you specify which database fields are to be displayed in the project list, you can
find further below.

The amount of space in a sheet is, by its nature, limited. Use the Project Info View to
display additional, andmore detailed, information on the project.

Quick info on a project
When youmove themouse pointer over a project, an info window will open, in which
you'll find information on this project. You can specify which information will be shown.

1. To do so, open theDatabase > View > Customize Views dialog box.
2. Select the Tool Tip View entry in theView list.
3. Select theProject entry in theRecord type list.
4. Select the database fields that you want to see in the brief information.
5. Close theCustomize Views dialog box.

Activities in the project list

Viewing data belonging to a project
Double click on the project when you want to view, load or edit, the data on this project.
You will then automatically switch into the Document View.

Sorting a project list
You can sort the project list. As a sorting criterion you can use every database field that
is displayed in the project list. To do this, click once on the header of the columnwith
the database field you want to use, to have the project list sorted in an ascending or
descending order, according to this database field. The columnwith the current sorting
criterion will be identified by an arrow next to the column header.
Clicking it oncemore will reverse the sorting order. The arrow will show the current
direction of sorting.

Grouping project list
In many cases, you will be able to group the records in the project list in such a way
that you will be able to reach the records you're interested in with only a few clicks.

Right click on the header of the column bywhich you want to group. Use theGroup by
this Field command from the context menu.

You can, for example, group the projects by client. That is to say, the list view changes
into a tree view. All of the records have then be allocated the group criterion, e.g., the
database field [Client]. Every field entry produces a superordinated entry in the tree
view, e.g., "Client: Production". To expand the entries belonging to a particular
criterion, click the small plus sign in front of the criterion.

Filtering the project list
You can filter the project list according to any criterion. This will make your search
easier by limiting the number of projects that are displayed. If, in your database, the
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database field [Project status] has been defined, you can, for example, have only the
projects with the status "In progress" displayed.

In the column header, under all of the displayed database fields, you'll find an input
field for the text, according to which you want to filter. Simply enter the text there, by
which you want to filter.

Use theDatabase > Set Default Project Filter command to have the active data filter
automatically used for the sample list, when your software is started.

Opening the context menu
Select a record in the project list and click with the right mouse button. In this way you
can open a context menu that offers you a number of commands you can use for, e.g.,
editing records.

Here, you can, for example, find theExport toWorkbook command. Use this
command from the Project List View's context menu export the project list to a
workbook. You can, e.g., also save a workbook as anMS-Excel file. The project list
will then be exported exactly as it is right now displayed in theDatabase tool window.
If, e.g., a filter is active, only the projects that correspond to the filter criteria will be
listed in the workbook.

Assigning database fields for the project list

Making database fields available for the project list
You can specify which database fields will be shown in the project list. To do so, use
theCustomize Views dialog box, and select theProject List View entry in theView list.

Fading database fields in and out.
Once you havemade database fields available for the project list, you can quickly fade
them in or out. Right click the title line to open a list with all the available database
fields. Select the database field you want. The database fields that are on display will
be indicated by a checkmark.

The definition of database views is user-dependent. That means that a colleague who
opens the same database with his passwordmaywell see other information.

00040

2.3.2. Project Info View
In the Project Info View, you can for every project, view the way the database fields
have been filled out for this project. You will find this database view in your database's
Project View.
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The illustration shows the schematic construction of theDatabase tool window in the
Project View. You can find the Project Info View (1) at right side of the tool window.
There, you will find information on the project that has been selected in the project list
(2).

Note: The Project Info View can't be displayed when the database window is very
small. Enlarge theDatabase tool window correspondingly.

Customizing the appearance of the Project Info View

Adding or hiding database fields
You can specify which database fields will be shown. To provide you with a better
overview, the database fields can also be distributed over several tabs.
To do so, right click one of the database fields in the Project Info View. From the
context menu, select theCustomize Views command. In theCustomize Views dialog
box, theProject Info View entry will have already become active, and you can select
the database fields you want.

Activities in the Project Info View

Information in the Project Info View
Select a record in the Project List View. The Project Info View then shows you
numerous database fields together with their field entries, for this record.

Editing entries in database fields
Use the Project Info View to edit existing entries in database fields. You can, however,
only change fields which have a white background (2). Fields with a gray background
(3) serve only as information.
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You can edit existing entries in database fields. The illustration shows you various
possibilities for working in the Project Info View. You'll find the explanations in the text.

Confirm Changes

As soon as you have changed an entry in a database field, the two buttons in the
Database tool window's toolbarConfirmChanges andAbort Changes (1) will become
active. Click theConfirmChanges button to have your changes adopted.

You can also set up your database in such a way that entries in database fields can be
changed without an inquiry beingmade. To do so, clear theAsk before saving record
changes check box. You will find this check box in the Tools > Options > Database >
General dialog box.

Expanding groups
To help you keep track of everything, you can assign the database fields to groups.
You can reduce every group in the Project Info View to its header. This enables you to
hide information that doesn't interest you. Double click on a group's header (4), to
reduce the size of the group, or to expand it again.

Opening context menus
The Project Info View offers you two different context menus.

Right click on a database field (5). This will open a context menu containing numerous
commandswith which you can e.g., change the appearance of the database view.

Right click on an entry in a database field (6). This will open a context menu containing
numerous commandswith which you can reformat the field entries.

Copying and inserting field entries
Your software offers a simple way of copying entries in database fields into the
clipboard. To do so, right click the contents of the database field that you want to copy
(6). From the context menu, use theCopy command to copy the complete entry in that
database field into the clipboard. You can then insert the copied text into another
database field, or also into another application program, such as, e.g., MS-Word. To
do so, use the [Ctrl + V] shortcut.

00041
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2.3.3. Project Filter View and Document Filter View
TheDatabase tool window is divided into several areas. In each of these areas, a
special database view is displayed.

In a filter view, you can select predefined data filters with which you can filter the
records. You can find a filter view in your database's Project View and Document
View.

The illustration shows the schematic construction of theDatabase tool window in the
Project View (1) and in the Document View (2). The filter view is framed in black in
both illustrations.
Please note that you can switch the filter view on and off by using this button (3).
When a data filter is active, the information, how many records fulfill the filter criteria,
appears at the bottom edge of theDatabase tool window (4). This information
disappears as soon as all of the records are oncemore on display.

Showing or hiding the Filter View
To switch the filter view on in theDatabase tool window, click theShow / Hide Filter
View button. You can find this button on theDatabase tool window's lower toolbar.
When the filter view is on display, this button appears clicked. You can recognize this
status by the icon's colored background.
By clicking a button that appears clicked, you switch off the filter view.

Activities in the Filter View

Selecting the database view
Switch to the database view in which you want to filter records. In the Project View you
can find the Project Filter View and in the Document View, the Document Filter View.
Please note that the data filter is only in each case valid for the view in which you apply
the data filter.

For example, switch to your database's Project View when you only want to have the
projects displayed that currently interest you.With the data filter ( [Creation date] >=
'01.04.2007' ) will, for example, only the projects be displayed that were set up after
the first of April 2007.
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Switch to your database's Document View when you want to search for specific
documents belonging to a project. Here, you can, e.g., have only the images displayed
that belong to a project, and have all the other document types hidden.

List of all data filters
In the filter view, you can find a list with all of the data filters that have been defined for
the active database, next to theApply button.

To define a data filter, use theDefine Filter dialog box. Data filters that you often use
can be saved for your databases. Data filters are user dependent. Another user can
therefore not see your data filters and vice versa.

As soon as you have selected a data filter, the filter criteria that have been defined in
that data filter will be displayed in the filter view.

Data filters with variable conditions
When you define a data filter, you can either define a filter criterion completely, or
assign it a variable value.

A completely defined data filter is, e.g., ([Client] equals "Production" ). In this case you
are filtering all of the records in which, in the database field [Client], the field content
"Production" has been entered.
A variable filter criterion is, e.g., ([Client] equals "(Variable)" ). Then, in the filter view,
the database field [Client] will appear as the filter criterion. Later in the filter view, does
the user then specify for precisely which client is to be searched.

Applying a data filter
In the Filter View, click theApply button to apply the displayed data filter.

Then, in theDatabase tool window, only the records that comply with the filter criteria
will still be shown.When the ( [Client] equals "Production" ) data filter is active, the
records of a specific client, for example, will still be displayed. All other recordswill be
hidden.

When a data filter is active, the information, how many records fulfill the filter criteria,
appears at the bottom edge of theDatabase tool window. This information disappears
as soon as all of the records are oncemore on display.

Removing a data filter
When a data filter is active, theRemove Filter button will be available. You can find this
button on theDatabase tool window's lower toolbar.
Click this button to remove the data filter and have all of the database's records
displayed oncemore.

00195

2.4. Document View of the database
In theDatabase tool window, you can choose between different main views. The
Document View will be the view in which you usually work with the database. In the
Document View you can view, load or edit all of the data that belongs to a project. You
can insert new data on a project in the Document View.
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Structure of the tool window in the Document View
TheDatabase tool window is divided into several areas. In each of these areas, a
special database view is displayed. You can change the size of individual areas, by
dragging the area boundary with your mouse button depressed.

The illustration shows the schematic construction of theDatabase tool window in the
Document View.
The Document View contains two toolbars (1) with themost important functions you'll
need when working with a database.
The tool window is divided up into the viewsProject Header View (2), Sample List
View (3), Document Info View (4), Gallery View (5) and Document/Live-image View
(6). Aswell as that, you can also filter the documents in the Document Filter View (7)
and by doing this, have only the documents that interest you displayed.

Database views within the Document View
Each database view within the document view shows different information and allows
different actions.

Switching to the Document View
There are several ways of switching to the Document View:

l In the Project View, double click on a project to switch to the Document View.
l Click theShow Documents button to switch to the Document View. You can find
this button on theDatabase tool window's lower toolbar. In the Document View
this button appears clicked. You can recognize this status by the button's colored
background.

Activities in the Document View
The following actions are possible in the Document View.
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1. Set up a new sample folder in the Document View. To do so, use theDatabase >
Insert > Sample... command.

2. Acquire an image with your software and insert the image into the database.
3. Load images or other documents which were inserted in a sample folder in the

database.
4. Edit images that have already been saved in a database. For example, carry out

another measurement on the image or improve the image contrast so that the
image can be inserted into a report better.

00029
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2.4.1. Project Header View
You can find the Project Header View in theDatabase tool window's Document View,
immediately below the toolbar. Here will be shown, e.g., the name of the active
project. Use the buttons in the Project Header View to change the active project
without having to switch to the Project View.

The illustration shows the schematic construction of theDatabase tool window in the
Document View.
The Project Header View (1) shows you which project you are in.

Activities in the Project Header View

Adapting the view
In the Project Header View, only one single database field will be shown. You can
specify which database field is to be displayed in the Project Header View. Choose a
database field that unambiguously characterizes the project, e.g., the project number,
or the project description.
To do so, right click the Project Header View. From the context menu, select the
Customize Views command. In theCustomize Views dialog box, theProject Header
View entry will already have become active, and you can select the database field you
want.

The definition of database views is user-dependent. That means that a colleague who
opens the same database with his passwordmaywell see other information.

Switching to other projects
Click the [ < ] button to switch to the previous project. Click the [ > ] button to switch to
the next project.
The projects are arranged according to the way they have been sorted in the Project
List View.

00052
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2.4.2. Sample List View
In the Sample List View, you can see the sample folders that have already been
inserted into the database. You will find this database view in your database's
Document View.

The illustration shows the schematic construction of theDatabase tool window in the
Document View.
The sample list (1), you can find on the left-hand side of the tool window.

Information in the sample list

Sample list
The sample list shows all of the samples that belong to the active project. The
database is structured hierarchically. "Samples" are there the only records that can be
inserted immediately beneath the "Project" database level. These records need not
necessarily be "Samples". Depending on the way your laboratory is organized, you
can also structure your projects by other criteria, e.g., by acquisitionmethods.

Information on the samples
Numerous database fields will be listed for each sample. In every column you can find
the corresponding entries for every sample in the database field.
The amount of space in a sheet is, by its nature, limited. Use the Document Info View
to display additional, andmore detailed information on the sample.

Activities in the sample list

Viewing documents that belong to a sample
Select an entry in the sample list. Then all of the documents belonging to this sample
will be displayed in the database gallery. These can be images, but also other
documents, such as, e.g., workbooks or evenMS-Excel sheet.

Opening the context menu
Select a record in the sample list and click with the right mouse button. By doing this
you will open a context menu with a number of commands.
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Choose, e.g., theDisplayGallery command to have the sample folder displayed as a
thumbnail, instead of as a list. When you do so, the sample folder will be displayed as
an icon.

00048

2.4.3. Document Info View
In the Document Info View, you can for every document view the way the database
fields have been filled out for this document. You will find this database view in your
database's Document View.

The illustration shows the schematic construction of theDatabase tool window in the
Document View.
You will find the Document Info View (1) at the left-hand side of the tool window. The
information pertains to the record, that has been selected either in the sample list (2) or
in the database gallery (3).

Select a record. You can select the record either in the sample list or in the database
gallery.
The Document Info View then shows you numerous database fields together with
their field values, for the selected record.
Please note that the database fields that are displayed depend on the type of record
selected.When you select a sample in the sample list you will see other database
fields than when you select, for example, an image.
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2.4.4. Database gallery
In the database gallery you will see thumbnails of all of the images that are contained
in the sample folder you have chosen. Other documents (texts, reports, MS-Excel
sheets etc.) will be displayed as an icon.
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The illustration shows the schematic construction of theDatabase tool window in the
Document View.
You will find the database gallery (1) at the bottom of the tool window.When you
select an image, you can view that imagemore precisely in the Document/Live-image
View (2).

Activities in the database's Gallery View

Loading documents into the Document/Live-image View with a simple
click
In the Document/Live-image View (2) select theDisplay current database image
option. When you then click once on a thumbnail in the Gallery View, the image will be
loaded into the Document/Live-image View. The Document/Live-image View is an
area in theDatabase tool window in whichmore room is available than in the database
gallery, for displaying images.
If you want to view an image in still more detail, double click the image to switch to the
"Full Screen Image"mode.

Loading documents into the "Full Screen Image" mode with a double
click
When you double click on a thumbnail the document will, by default, be displayed in
the "Full Screen Image"mode. The prerequisite for this is that your software is able to
open the selected document type. The "Full Screen Image"mode displays the active
document in themaximum size that your monitor allows. The user interface will be
completely faded out.
Please note that in the "Full Screen Image"mode, both a scale bar and an info stamp
can also bemade to appear in an image.
To switch off the full screenmode and return to the "normal" user interface, use the
[Esc] key, or click theExit button.

With types of document that your software can't open (e.g., MS-Word files or MS-
Excel files), the program that these types of document are assigned to under MS-
Windowswill be started.

Loading documents into the document group
When you want to load an image into the document group, e.g., to measure it, select
the image in the database gallery, then use the Load Documents command in the
context menu. You will then automatically switch into theProcessing layout.
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When you want to work with your database oncemore, use theView > Layout >
Database command.

Changing the default settings for the loading of documents 
You can also alter the default setting that determines how a document reacts when
you double click it. To do this, use the Tools > Options... command. Select the
Database > General entry. From theWhen a document record is double-clicked list,
select the Load the Document entry. With this setting the documents will be loaded
from the database gallery into the document group with a double click.

Changing the size of thumbnails
You have the choice between two sizes of thumbnail. Right click in the background of
the database gallery, and use theSmall Thumbnail Images command to switch
backwards and forwards between the two thumbnail sizes. When you use a smaller
thumbnail size you will be able to load far more documents into the database gallery.

Altering the thumbnails' labeling
You can set which database field is to be used for labeling the thumbnails.
To do so, click your right mouse button in the database gallery's background. From the
context menu, select theCustomize Views command. In theCustomize Views dialog
box, theGallery View entry will have already become active, and you can select
another database field for the labeling.
For the Gallery View, choose amandatory field from theRecord Fields field table. By
doing this, you'll make sure that there will be an entry in the database field for every
single record, and in that way, ensure that the thumbnail can be labeled.

The definition of database views is user-dependent. That means that a colleague who
opens the same database with his passwordmaywell see other information.

Making information on documents appear
Select a document in the database gallery.
The Document Info View then shows you numerous database fields together with
their field entries, for the selected record.

Quick info on the documents
When youmove themouse pointer over a thumbnail, an info window will open, in
which you'll find information on this thumbnail. You can specify exactly which
information will be shown. To do so, use theCustomize Views dialog box, and select
the Tool Tip View entry in theView list. Please note that you can set up different
database fields for every record type, in the Tool Tip View.

00050

2.4.5. Document/Live-image View
TheDocument/Live-image View is used to display the live-image or to display the
image that is currently selected in the database gallery.
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The illustration shows the schematic construction of theDatabase tool window in the
Document View.
The Document/Live-image View (2) is located at the top of the tool window. The
database gallery (1), you can find at the bottom of the Document View of the tool
window.

Displaying the live-image

If you are working at a workstation that you can use to acquire images, the
Document/Live-image View will also be used to display the live-image. To do this, in
the Document/Live-image View (2) select theDisplay live image option.

Toggling live mode
Click the Live button in theCamera Control toolbar to start the livemode.

Click theSnapshot button to stop the live-image and thus acquire a new image.

Display of the live status
The status of the livemodewill be shown in the Document/Live-image View behind
theDisplay live image control
The name of theDisplay live image option isDisplay live image (active)when your
camera is in the livemode.
The name of the option isDisplay live image (stopped)when the livemode has been
switched off.

Displaying the current database image

Select theDisplay current database imagewhen you wish to closely examine an
image from the database. To do this, select the required thumbnail in the database
gallery.

Toggling between the live-image and a database image
When you view the current image in the database, you do not alter anything on the
status of the livemode. You can also view an image in the database when the live
mode is switched on.
Therefore, you can switch backwards and forwards between the live-image and an
image from the database however you want to.
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Activities in the Document/Live-image View

Changing the displayed image's zoom factor
There are several ways in which you can alter the zoom factor in the Document/Live-
image View.

l When youmove your mouse pointer on the Document/Live-image View, you can
zoom into, or out of, an image, with themouse wheel. With the left mouse button
depressed, you canmove the enlarged segment of an image and in this way have
another part of the image displayed in thismagnification.

l Use the commands of the context menu to adjust the zoom factor. You open the
context menu by clicking with the right mouse button.
This possibility for changing the zoom factor via the context menu, doesn't exist for
the live-image.

Viewing the image in detail in the Full screen mode
You can view an image that has already been saved as a record in the database, in its
full resolution, on your monitor. Right click the image in the Document/Live-image
View, then select the Full Screen Preview command from the context menu.

The full screenmode displays the active document in themaximum size that your
monitor allows. The user interface will be completely faded out.

Note: Tomake it possible to view the image in Full screenmode, youmust have
already loaded it. That's to say, the image data has to be requested from the File
Server and transferred to your database client. Depending on how quick your network
connection is, on how large the image is, and which document storage type you use,
loading an image can take quite some time.

To switch off the full screenmode and return to the "normal" user interface, use the
[Esc] key, or click theExit button.
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2.5. Search Results View of the database
In theDatabase tool window, you can choose between different main views. In the
Search Results View, all of the records that were found during the last database
search, will be shown. The Search Results View is empty when you haven't yet made
any database searches. The Search Results View will be automatically update every
time youmake a new database search.

Structure of the tool window in the Search Results View

The illustration shows the schematic construction of theDatabase tool window in the
Search Results View.
The Search Results View contains two toolbars (1) with themost important functions
you'll need when working with a database. In the Search View (2), you can view the
search conditions for the current database search, and also start a new database
search. The tool window is divided up into the viewsSearch Results (Gallery View)
(3), Image Preview (4), and Record Details View (5).

Database views within the Search Results View
Each database view within the Search Result View shows different information and
allows different actions.

Displaying search results in a table
You can also have the search results displayed in a tabular form. Click the Search
Results View's gallery with your right mouse button to open a context menu. Select the
Table View command.

Exiting the Search Results View
There are several ways to leave the Search Results View.

1. Select a record in the gallery of the Search Results View.
Click your right mouse button and select theGo ToRecord command in the
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context menu.
l Your software will then automatically display the sample or the project to which
the record you've selected belongs. To do this, your software will automatically
switch to the appropriate database view.

2. Click theShow Projects button to switch to the Project View of the database. You
can find this button on theDatabase tool window's lower toolbar.

3. Click theShow Documents button to switch to the Document View of the
database. You can find this button on theDatabase tool window's lower toolbar.

Activities in the Search Results View
The following actions are possible in the Search Results View.

1. Searching for more records.
2. You can gain information about the record in the Record Details View. You can

also change the entries for a record there.
3. Navigate from a record you have found back to the superordinate database folder.

To do so, use theGo ToRecord command in view (3)'s context menu.
4. View an image in full resolution. To do so, use the Full Screen Preview command

in the Image Preview's context menu.
00194

2.5.1. Search View
You can find the Search View in the database's Search Results View.

Functions of the Search View
l Firstly, the Search View has a solely display function. In it, you can see the search
conditions for the last database search. The documents on display there
correspond to those search conditions.

l In addition to the solely display function, you can also load saved search
definitions in the Search View, and carry out a new database search.

The illustration shows the schematic construction of theDatabase tool window in the
Search Results View. You can find the Search View (1) on the top left-hand side.
Please note that you can show and hide the Search View by using this button (2).
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Toggling Search View
To switch the Search View on in theDatabase tool window, click theShow / Hide
Search View button. You can find this button on theDatabase tool window's lower
toolbar. When the Search View is on display, this button appears clicked. You can
recognize this status by the icon's colored background.
Click the button that appears clicked to hide the Search View if you needmore room
for the records on display.

Activities in the Search View

You can use the Search View to carry out a new database search.

List of all saved search definitions
In the Search View, you can find a list with all of the search definitions that have been
defined for the active database to the left of theSearch button. You will also find the
data filters there, since you can, at any time, also use a data filter for a database
search.
As soon as you have selected a search definition, the search conditions defined there
will be displayed in the Search View.

To define and to save search conditions as a file, use theDefine Search dialog box.

Using variable search conditions
When you define a search condition, you can either define a concrete value or leave
the value as a variable. Where a variable search condition is concerned, the user has
to add the concrete value for which the search is to be carried out, before the database
search can start.

For example: A completely defined search condition is, e.g., ([Client] equals
'Production' ). In this case you are searching for all of the records in which, in the
database field [Client], the field content 'Production' has been entered.
A variable search condition is, e.g., ([Client] equals '(Variable)' ). Then in the Search
View, the database field [Client] will appear as the search condition. First in the Search
View, does the user then specify for precisely which client is to be searched.

Carrying out a search
Click theSearch button in the Search View to carry out the search.

When a database search has been carried out, the Search View will be updated. Only
the records that fulfill the search conditions you've set will be displayed.When the ( 
[Client] equals 'Production' ) search condition has been selected, only the records of a
specific client, for example, will be displayed.

00042

2.5.2. Search Results (Gallery View)
In the Search Results View the results of a database search will be displayed. You will
find this database view in your database's Search Results View.
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The illustration shows the schematic construction of theDatabase tool window in the
Search Results View.
In the Gallery View (1), you will see the thumbnails of all the images that have been
found during the last database search. Other documents (texts, reports, MS-Excel
sheets etc.) will be displayed as an icon.
You can find the Image Preview (2) on the top right-hand side.

Choosing between the Gallery View and the Table View
In the database's Search Results View, you can view the results of a database search
either in the Gallery View as thumbnails, or as a results sheet. To output the results in
a sheet, right click on the area (1) of theDatabase tool window. Select theDisplay
Gallery command from the context menu.

Activities in the Search Results (Gallery View)

Loading documents into the Preview with a simple click
When you click once on a thumbnail in the Gallery View, the image will be loaded into
the Preview. The Preview provides considerablymore space on the screen for image
display than theGallery View.

Double clicking in order to go to the corresponding record
When you double click on a record, your software will automatically display the sample
or the project to which the record you've selected belongs. To do this, your software
will automatically switch to the appropriate database view.

Loading documents into the document group
If you want to load an image into the document group, e.g., to measure it, select the
image in the Gallery View, then use the Load Documents command in the context
menu. You will then automatically switch into theProcessing layout.
When you want to work with your database oncemore, use theView > Layout >
Database command.

Making information on records appear
Select a record in the Gallery View.
The Record Details View then shows you numerous database fields together with
their field values, for the selected record.
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Quick info on the documents
When youmove your mouse pointer over record in the Gallery View, an info window
will open, in which you'll find information on this thumbnail. You can specify exactly
which information will be shown. To do so, use theCustomize Views dialog box, and
select the Tool Tip View entry in theView list.
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2.5.3. Image Preview
In the Search Results View, all of the records that were found during the last database
search, will be shown. The Image Preview is there to show you an image that has just
been found as the result of a database search.

The illustration shows the schematic construction of theDatabase tool window in the
Search Results View.
The Image Preview (2) is located on the top right of the tool window. You can find the
DatabaseGallery (1) at the bottom-left.
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2.5.4. Record Details View
In the Search Results View, all of the records that were found during the last database
search, will be shown. In the Record Details View, you can for every record, view the
way the database fields have been filled out for this record. You can find this database
view in your database's Search Results View.

The illustration shows the schematic construction of theDatabase tool window in the
Search Results View. Information on the records found (1) can be found on the right-

OLYMPUS Stream Database User Manual 33



2.  User Interface
2.5.   Search Results View of the database

hand side in the Record Details View. The information refers to the record that has
been selected in the database gallery (2) or in the results sheet.

Determining the "Record Details" tool window's appearance
When you load a document from the database to edit it, or to makemeasurements,
use theRecord Details tool window to view the details that have been saved in a
database for this document. The information displayed in theRecord Details tool
window, corresponds exactly to the information that you have displayed in the Record
Details View of theDatabase tool window. That's to say, when you determine the
appearance of the Record Details View, you also determine the appearance of the
Record Details tool window.

00202
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3. Working with a database
3.1. Opening the database

When you want to work with a database, use theOpenDatabase dialog box. You
have to open the database when you want to load documents (e.g., images, charts or
workbooks) that are contained in that database, or to insert new records into it.
Only one database can be opened at a time. As soon as you open another database,
the one that has already been opened will be automatically closed.

Prerequisite: To be able to open a database, youmust be registered as a user with the
database server. The database administrator takes care of that.

There are several ways in which you can open databases:

1. Use theDatabase > Open... command.
2. Use the File > Open > Image... command.
3. On theStandard toolbar, click the small arrow next to theOpen button to open a

context menu with all of the available commands you can use for loading files.
Select theDatabase entry from the context menu.

4. You can find a list of the databases that were last opened, in theDatabasemenu.
Simply select one of the databases that is listed.

5. When no database has been opened, in the emptyDatabase tool window, you'll
find a list of the databases that have recently been opened. Click the name of the
database you want, to open it.

Selecting a connection mode
If you want to open a database, you first have to register your PC with the database
server. The appearance of theOpenDatabase dialog box depends on the connection
mode you have selected. Click theOptions... button in theOpenDatabase dialog box
to select the connectionmode. Depending on the connectionmode, you can either use
a database connection file (Case 1), or you can enter the connection datamanually
(Case 2).

Case 1: Using the database connection file
Click theOptions... button in theOpenDatabase dialog box.
If you want to adopt all of the information that is necessary for logging-on to a database
from a text file, select theUse database connection file option. This text file has the file
name extension DBC. That will save you a great deal of writing. Close theOptions
dialog boxwithOK.

TheOpenDatabase dialog box now contains theDatabase connection file group.

Select the database connection file for the database you want to open, in the
Database connection file > File name list. By default, the database connection file that
was last selected will already have been preselected in the File name field.
Click the [...] button if you want to open a database connection file that is not yet
present in the File name list.
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You will see a description of the database you have selected in theDatabase
connection file > Description field. This short descriptionmust be entered by your
database administrator when the database connection file is set up. Should no short
description have been saved when the database connection file was set up, this field
will be empty.

Case 2: Entering connection data manually
Click theOptions... button in theOpenDatabase dialog box.
If you want to enter all of the information that is necessary for logging-on to a server
manually, select theEnter connection datamanually option. Use this option when,
e.g., you only want to log onto a database on one occasion. To log-onmanually, you
require the following information: the databasemanagement system, the name of the
database, and the name of the server on which the database is located. If you are not
certain about anything, contact your database administrator.
Close theOptions dialog boxwithOK.

TheOpenDatabase dialog boxwill then contain theDatabase group.

Enter the name of the database in theDatabase > Database Name field. If a server
has already been selected, all of the databases that are on the selected database
server will be automatically listed.

In theDatabase > Server field, enter the name of the server on which the database
can be found. Should you not know the exact name of the server, click the [...] button to
open theSelect Servers dialog box. Select the server from the list of the available
database servers, then click theAdd >> button. Click theOK button to close the dialog
box, and to return to theOpenDatabase dialog box.

Select the databasemanagement system in theDatabase > Database system list.
Select theMicrosoft SQL Server entry, for example, if you use the SQL Server as your
database server.

User's details
When you open a database, you need to prove that you are allowed to open the
database. To do so, you specify a user name and password. You need to be
registered as a user in the database with this user name and password.

Single Sign On
In theUser > Authentication list, choose theSingle SignOn entry if you are logged on
to the PC where your software runs, with your user name. The current log on data for
theMS-Windows operating systemwill also be used for logging on to the database. In
this case, you will neither need to enter a password nor a user name.

For Single SignOn authentication, there needs to be a user profile set up for you on
theMS-Windows operating system. You also need to be registered as this user in the
database.

Windows Login
If you want to use the log-on data with which you are logged on to theMS-Windows
operating system also for logging-on to the database, select theWindows Login entry
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in theUser > Authentication list. As opposed toSingle SignOn authentication, you
need to explicitly enter your user name, password and domain.

This authentication allows you to open a database from a computer on which you are
not logged on with your user name.

ForWindows Login authentication, there needs to be a user profile set up for you on
theMS-Windows operating system. You also need to be registered as this user in the
database.

SQL Authentication
Select theSQLAuthentication entry in theUser > Authentication list if you want to use
database specific log-on data. In this case, you will have to enter both your password
and your user name every time you log on. The user name and password will be
assigned by the database administrator within the databasemanagement system,
e.g., on an SQL server.

For theSQLAuthentication option, there needs to be a user profile set up for you on
the databasemanagement system. In this case, the log on data are completely
independent of your MS-Windows log on data.

Using a database as a standard database
To turn the current database into a standard database, select theUse as standard
database check box.

The standard database will normally be automatically opened when you start your
software. Use theOptions > Database > Standard Database dialog box if you want to
change the way the standard database behaveswhen your software starts.

Note: The settings for the standard database are user dependent. For this reason,
another user can have defined another database as a standard database.
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3.2. Inserting data into a database

3.2.1. Overview
All users who have the necessary permissions can insert records into a database.
Here, records canmean structuring records such as project folders and sample
folders, but also images, reports, charts and all other documents that youmaywant to
save in your database.

While inserting records, the database fields you are to fill out correspond to the record
type. Thismeans that you can enter different information about images than about
charts.
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Important terms

What are structuring records?
For the better structuring of a database, there are structuring record types, that are
indicated within the database by a folder icon. A record that belongs to this record type
isn't referenced to a document, but instead contains only the information that is
entered in the database fields.
Structuring records are, e.g., "Projects". They are displayed in the your database's
Project View.

What exactly are documents?
Documents are, for example, images, workbooks or diagrams.
You can of course insert all of the documents that you create with your software, or
load into it, into a database.

What exactly are external documents?
Aswell as the documents that you have loaded in your software, you can also insert
any other files of your choice that you have saved on a data storagemedium. That also
applies to external documents. These are document types that are not supported by
your software, e.g., MS-Word documents with the file extension DOC.

Various ways of inserting data into a database

There are several ways in which you can insert data into a database. Use the
commands in theDatabasemenu, or from various context menus, or click the buttons
in theDatabase tool window. You can also insert documents byDrag&Drop.
All of these possibilities will be described in the text that follows.

Menu commands
Use theDatabase > Insertmenu commands. The following commands are available:

l Insert Open Documents
l Insert All Open Documents
l Insert FromFiles
l Insert structuring record

Buttons
Use one of the buttons located on theDatabase tool window's upper toolbar.

Commands from the context menu
Use the Insertmenu in the context menu. You open this context menu by right clicking
on one of the following views in theDatabase tool window.

l Project List View
l Sample List View
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You can also insert a single document, for example, an image, directly out of the
document group into the database. Right click the document's title in the document bar
to open a context menu. The context menu will contain the Insert into Database
command.

Drag&Drop
Drag a document from theMS-WindowsExplorer into the database gallery.

To do this, switch to the database's Document View. Then select the record into which
you want to insert the document, in the database. Then drag the document from the
MS-WindowsExplorer onto the database gallery.

Acquiring images
When a database has been opened, every image you acquire with your software will
be automatically saved in the active database.

Notes on how to insert data into a database

When you insert records into a database, please pay attention to the points listed
below:

The database is structured hierarchically
You cannot insert records into every database level.

Inserting documents that have been changed
When you load a document from a database into your software, and edit it there, then
close the document again, there are a variety of ways in which your software can
react. The database administrator can, e.g., specify that the existing document is to be
replaced, or that the altered document can only be inserted into the database as a new
record.

Moving images to another database folder
If you have accidentally inserted documents in the wrong place, you canmove them to
the correct database folder at a later time. To do so, use theCut andPaste
commands. You can find the commands in the context menu of the database window.
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3.2.2. Inserting projects and samples into a database
The database is structured hierarchically. The database that you have been provided
with has twomain levels, namely "Project" and "Sample," on its topmost database
levels.

Inserting a new project
Project folders can be found on the topmost database level that is shown in the Project
View.

1. To do this, switch to your database's Project View. Only there can you set up
projects.

OLYMPUS Stream Database User Manual 39



3.  Working with a database
3.2.   Inserting data into a database

The schematic illustration shows your database's Project View. In the Project View,
theShow Projects button (1) appears clicked. Click the Insert Record button (2) to set
up new projects. You will then find the new projects in the project list (3).

2. Click the Insert Record button. You can find this button on theDatabase tool
window's toolbar.
l A picklist opens.

3. Select theProject... entry.
l The Insert Project dialog box opens. The dialog box contains input fields for a
variety of database fields that relate to the project.

l The database fields, that are to be filled out in the Insert Project dialog box,
have been specified by the database's administrator.

l You can still add to and edit many of the entries relating to the project, later on,
in the Project Info View.

4. When you use the "Enterprise Edition" of the database, thePermission Set group
will be displayed in the Insert Project dialog box. In this group, you specify who is
allowed to look at, and alter this project.
l By default, this entry is namedEveryone. In this case, every database user is
allowed to look at, and alter, the new project.

5. If you have changed the current permission set and want the new permission set
to be the default from now onwhen you set up new projects, click theSet as
default permission set button.
l The permission set used for this new record will then also be used for all child
records that you create for this project. All documents saved under this record
will also have the same permission set.

6. Fill out the other input fields, then click the Insert button to set up this project.
l The new project will then be displayed in the database's Project List View.
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l You can then set up sample folders for this project in the database, and insert
both images and documents relating to this project there.

Inserting a new sample folder
Within the project folders located on the topmost database level, you can set up as
many sample folders as you like. Sample folders are shown in the database's
Document View. Sample folders are structuring records, exactly the same as project
folders are. When you insert a sample, by doing so, you set up a database folder into
which you can insert all of the documents belonging to this sample.

1. You can only insert a new sample folder into a project. Because of this, first select
the project into which you want to insert the samples in the database.

2. Switch to your database's document view. Only there can you set up sample
folders.

The illustration shows a part of your database's Document View. In the Document
View, theShow Documents button (1) appears clicked.
Click the Insert Record button (2) to set up new sample folders. The project, to which
the inserted sample folders belong, is shown in the database window (3).
You can find new sample folders in the Sample List View (4).

3. Click the Insert Record button. You can find this button on theDatabase tool
window's toolbar.
l A picklist opens.

4. Select theSample... entry.
l The Insert Sample dialog box opens. The dialog box contains input fields for a
variety of database fields that relate to the sample.

5. Fill out the input fields, then click the Insert button to set up this sample.
l The new sample will then be displayed in the database's Document View.

6. If you want to insert several samples that are similar into the database, you can
save all the settings that youmade for this sample to a special clipboard. To do
this, click theCopy button.When you insert the next sample into the database,
click thePaste button, located below theCopy button in the insertion dialog, to
copy the contents of this special clipboard to the corresponding fields in the Insert
Sample dialog box.
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3.2.3. Automatically saving images that have been acquired in a
database

When a database has been opened, every image you acquire with your software will
be automatically saved in the active database. You can, however, change this
behavior.

1. Open the database with which you want to work.
2. In the database, select the record into which you want to insert the document.

l When your database works according to the database template you were
provided with, you should first select the project folder. Then switch to your
database's Document View and select a sample folder.

Switch On Live display
3. Click the Live button on theCamera Control toolbar. In theDatabase layout, this

toolbar is displayed above the database window.
l The live-image is now switched on. It's possible that you can't yet see the live-
image in the database.

4. Select theDisplay live image (active) option, located at the top right in the
Database tool window's Document View.
l The live-image will then be displayed in the database window.

5. Take a look at the live-image on the right-hand side in the Document View.
6. Bring the sample into focus, then select the exposure time you want.
7. On theMicroscope Control toolbar, click the button with the objective that you use

for the image acquisition. In theDatabase layout, this toolbar is displayed above
the database window.
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The illustration shows your database's Document View. In the Document View, the
Show Documents button (1) appears clicked. In theDatabase layout, use the Live and
Snapshot buttons (2) to switch on the live-image, and to save the acquired image in
the database when the acquisition has beenmade. The live-image (3) will be
displayed in the database's Document View.

Inserting the image into the database
8. Make sure that the correct project folder and sample folder have been chosen.

You can now choose another database folder.
9. Click theSnapshot button on theCamera Control toolbar to end the livemode, to

acquire the image, and to have it automatically inserted into the database.
l The Insert Image dialog box opens.

10. Enter the required information on the image in the database fields.
11. Click the Insert button.

3.2.4. Switching off the automatic saving after image acquisition
When a database has been opened, every image you acquire with your software will
be automatically saved in the active database. You can change this behavior.

1. Open theAcquisition Settings dialog box.
To open this dialog box, click theAcquisition Settings button. You can find this
button, e.g., on theCamera Control toolbar.

2. Select theSaving entry in the tree structure.
3. Select the acquisition process for which you want to make the settings.

l Select, e.g., theSnapshot entry, when you want to have every image you
acquire, automatically saved in the database.

l In theAutomatic save group, theDatabase entry in theDestination list has
been selected. Because of this, the image will be automatically saved in a
database when it has been acquired.
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4. To change your software's behavior when images are acquired, select another
entry in theDestination list, located in theAutomatic save group. For example,
select theNo automatic save entry to switch off the automatic saving of images.

5. Close theAcquisition Settings dialog boxwithOK.

3.2.5. Inserting images into a database
All of the documents that you can create in your software or load into your software
can be inserted into a database. Aswell as that, you can also insert any other files that
have already been saved on a data storagemedium.
In these step-by-step instructions, you insert an image that has currently been opened
in your software.

1. Open the database with which you want to work.
2. Load the image into your software that you want to insert into the current

database. You can also create new documents. It doesn't matter whether the
documents have already been saved as a file or not.
Switch to e.g., theAcquisition layout, and acquire an image, or load an image from
your hard disk.

3. Switch to theDatabase layout.
4. In the database, select the record into which you want to insert the document.

l Please note that you cannot insert documents at every hierarchical database
level.

l When your database works according to the database template you were
provided with, you should first select the project folder. Then switch to your
database's Document View and select a sample folder.

l You can findmore information on the database's structure here.

5. Use theDatabase > Insert > Open Documents... command.
l Whenmore than one image has been loaded into the document group, the
Insert Open Documents dialog box opens. Select the check box in front of the
image you want to insert into the database, and confirm your selection withOK.

l The Insert Image dialog box opens.

l When you have acquired an image, the Insert Image dialog boxwill be
automatically opened, when a database has been opened.
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In the insertion dialog, the superordinated database folder (1) is displayed.
Here (2), you specify who is allowed to view this image.
In the insertion dialog box, enter all of the information that you want to save about this
image in the database. The record name (3) is automatically assigned. There you can't
make any entries.

Entering information on an image
6. Checkwhether the image is going to be inserted into the correct database folder.

In the Insert into group (1) the name of the database folder into which the image is
to be inserted, is shown.
Should you want to correct the database folder, click theBrowse... button.
l The Insert Into dialog box opens. TheDestination field gives you access to a
tree view. Browse to the correct database folder, then confirm this withOK.

7. If you use the "Enterprise Edition" of the database, thePermission Set group (2) is
displayed in the insertion dialog. Here, you specify who is allowed to see this
image. For example, if you select theEveryone entry, you will allow every user
who can log onto the database to view the image.

8. Enter the required information on the image in the database fields. Database
fields that are displayed in bold letters aremandatory fields andmust be filled out.
l Not every database hasmandatory fields. Therefore, it's possible that in your
database, none of the database fields are displayed in bold font.

l The record name (3) is assigned automatically by the database, therefore you
can't edit this field.

l Many of the entries youmake here can later be changed or added to, in the
Record Details View.

9. If you want to insert several images that are similar into the database, you can
save all the settings that youmade for this image to a special clipboard. To do this,
click theCopy button (4). When you insert the next image into the database, click
thePaste button (5) to copy the contents of this special clipboard to the
corresponding fields in the Insert Image dialog box.

10. Click the Insert button to save the current image in the database, together with the
information displayed.

When the image has been inserted
l The image that has been inserted has now been saved in the database.

l When the image has been inserted into the database, it will still remain open in
the document group. Should you no longer need the image, close it without
saving it again.

l Should the inserted image has already been saved as a file: During the
insertion a copy of the image will be saved in the database. The data itself won't
be changed during the insertion in a database.
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3.2.6. Inserting several documents into a database at the same
time

You can insert a number of documents simultaneously into a database.
In these step-by-step instructions, you insert documents that have currently been
opened in your software.

1. Open the database with which you want to work.
2. Load documents that you want to insert into the current database, into your

software.
3. First, select the record in the database into which you want to insert the document.

l When your database works according to the database template you were
provided with, you should first select the project folder. Then switch to your
database's Document View and select a sample folder.

4. Use theDatabase > Insert > Open Documents... command.
l The Insert Open Documents dialog box opens. This dialog box lists all
documents that have been opened. The icon in front of the document shows
you what type of document it is.

5. In the Insert Open Documents dialog box, you have to decide whether you want to
insert all of the open documents into the database, or only some of them. Select
the check box in front of each of the documents you want to insert into the
database.

6. Click theOK button.
l The Insert <document type> dialog box opens for the first document you want
to insert. The dialog box's appearance depends on which type of document you
insert into the database.

7. Enter the required information on the document in the database fields.

Case 1: Inserting information for every single document
8. Click the Insert button to save the current document together with the information

displayed in the database.
l The Insert <document type> dialog box for the next document opens.

9. Fill out the Insert <document type> dialog box for all of the documents.

Case 2: Inserting the same information for all documents
10. When you want to insert the same information for all of the documents, click the

Insert All button.
l All of the documents that have been selected are saved in the database one
after the other. The Insert <Document Type> dialog boxwon't open again.

l The database fields are filled out in the sameway for all of the selected
documents. The information will be adopted from the first record.

l The record namewhich is automatically assigned, is different for every record.
00337 13022014
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3.2.7. Copy Record Fields
You can copy the field content from one database record to one or more existing
database records. This is only possible if the records are of the same record type. In
theCopyRecord Fields dialog box, you can select the fields whose contents you want
to copy.

Opening the dialog box
Preparation: Use the Tools > Options... command and select theDatabase > General
entry in the tree view. Select theShow CopyRecord Fields dialog when copying
database records check box.

Then open a database and switch to the required database view. Select the record
whose fields you want to copy. Right click and select theCopyRecord Fields context
menu command in order to open the dialog box.

Example: You just inserted 10 samples into your database. Now you want to add
some additional information regarding these samples. For example, a sample
comment and an information about how the sample was prepared. As this additional
information is the same for all of the 10 samples that you inserted, you only need to
enter the data for the first sample. Then you copy the data (using a special clipboard in
your software) to the remaining 9 samples.

1. Switch to the database view you want and select the record whose contents you
want to copy.

2. Open the context menu and select theCopyRecord Fields command.
l TheCopyRecord Fields dialog box opens.

3. Select the fields whose contents you want to copy to the special clipboard in your
software.
l Not all of the fields can be selected. Fields whose contents cannot be copied
are displayed with a little lock icon .

4. If fields are selected whose contents you don't want to copy, you can clear the
selection.

5. Close the dialog boxwithOK.
6. In the current database view, select the record whose contents you want to copy

to the special clipboard. You can also select several records. Make sure that the
selected record is of the same type.

7. Open the context menu and select thePaste Record Fields command.
l If the record fields into which you want to copy the information are not empty,
you will receive a warningmessage that informs you that existing record fields
will be overwritten.

l If you close the warningmessage with Yes, the content of the special clipboard
is copied into the selected fields.

Note: If you want to insert several records of the same type, you can copy the
information that you entered for the first record and then paste it into the
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corresponding fields when you insert the subsequent records. To do so, use theCopy
andPaste buttons that are displayed in the Insert <document type> dialog box.
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3.3. Sorting, filtering and grouping records
There are several ways in which you can display records in theDatabase tool
window's various views.

3.3.1. Sorting records
In many cases you can sort the records into a list view in such a way that the records
that interest you are located at the top of the list and can therefore be easily found.

1. Switch to the view in which you want to sort your records. Sorting is possible in the
Project List View, Sample List View, and Search Results (Table View).
l The column headers show the database fields that will be displayed in the
current list view.

Sorting records in ascending or descending order
2. Click the column header with the database field bywhich you want to sort.
For example: In the current list view, the database field [Orderer] is displayed. Click the
column header to have all of the records sorted in alphabetical order by client's name.

l The sorting processwill be set. If the database is large, it can take a while
before all of the records have been sorted as you want.

l The database window's status bar shows the current way in which the records
are sorted.
Additionally, a small arrow in the column header indicates bywhich database
field the list is currently sorted.

3. Left click oncemore on the column's header to reverse the sorting order (e.g., to
sort numerical data in ascending order instead of descending order).
l The small arrow in the column header shows the direction in which they are
sorted.

l The sorting order set will be saved. The next time you start the program, the
same sorting order will be set.

4. To cancel the sortingmethod, right click the column header with the current
sorting criterion. Select theNoSorting command from the context menu.
l The recordswill now be sorted either by their insertion order or manually.

Sorting records by their insertion order
1. Right click one of your database's list views. By doing this you will open a context

menu with a number of commands.
l The context menu always contains the commandsSort Manually andSort by
Insertion Order. Which commands the context menu additionally contains,
depends on the current list view's configuration. TheSort by <database field>
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command exists for every database field that is displayed.
l You not only have this possibility to sort records in the list view, but also in the
Gallery View.

2. Choose theSorting entry from the context menu to open amenuwith several
commandswith which you can sort the lists.

3. Select theSort by Insertion Order command.
l The recordswill now be sorted in such a way that themost current records are
on the top.

Sorting records arbitrarily
For example: You are working with a certain sample folder that contains verymany
images. An overview image of your sample is also one of these images. You want to
have this overview image positioned at the top left in the Gallery View.

1. Switch to your database's Document View and select the sample folder.
2. From theGallery View's context menu, select theSorting > Sort Manually

command.
l Themanual sorting option is shown in the database window's status bar.

l You can now use your mouse tomove around the thumbnails however you
want, by Drag&Drop.

3. Drag the overview image byDrag&Drop to the position you want.
l Even when you choose another sortingmethod, your softwaremakes a note of
themanual sorting you've set up. As soon as you use theSort Manually
command again, the order of the recordswill be returned to the order you
manually set up.

3.3.2. Filtering records
In the database viewsProject View and Document View, you can set a data filter to
hide records that, at themoment, don't interest you. This will limit the records that are
displayed to a reasonable number.

Filtering by certain database fields
For example: In the step-by-step instructions that follow, it is assumed that the
database contains the [Project Status] database field. Filter for the [Project Status]
database field to see only the projects that are currently in progress.

1. Switch to the database view in which you want to filter the records. Switch to the
Project View if you want to filter the project list.
l You can also filter in the Document View. You will then only see the sample
folders of the current project, that corresponds to the filter criteria.

2. Checkwhether the database field bywhich you want to filter is on display in the
Project List View, or not. Should it not be displayed, change the Project List View
to include it.
l In the column header, under all of the displayed database fields, you'll find an
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input field for the text, according to which you want to filter.

3. Enter the text by which you want to filter, in the input field. For example, under the
[Project Status] database field, enter the text "In Progress".
l You don't have to enter the complete text. Your database will filter out all of the
recordswhose entries in the corresponding database field, begin with the text
entered. For example, simply enter "In". Your database will then filter out all of
the recordswhose project status begin with "In", for example "In progress" or
also "In process".

l All of the records that don't correspond to the current filter criteria will be faded
out.

l When a data filter is active, you'll see a small filter icon on the bottom left-hand
side, in the database window's status bar . There, the number of records that
fulfill the current filter criteria will also be shown. Themessage "26 of 12000
records" means, for example in the Project View that the database contains a
total of 12,000 projects of which 26 fulfill the filter criteria.

l When a data filter is active, theRemove Filter button will be available. You can
find this button on theDatabase tool window's lower toolbar.

4. You can simultaneously filter according to the entries in several database fields.
For example, in the input field under the [Employee] database field, enter
additionally the name of the employee, e.g., "Miller".
l Then only the projects with the project status "In Progress" which are at the
same time being worked on by the employee "Miller" will be displayed.

5. Click theRemove Filter button to remove the data filter and have all of the
database's records displayed oncemore.

Using the data filter automatically at startup
1. Choose a data filter so as to filter the project list. For example, filter by project

status.
2. Use theDatabase > Set Default Project Filter command.

l If you close your software now and restart, the chosen data filter will
automatically be set. The data filter which is set when the software is closed
does not influence this.

Working with complex data filters
Some data filters can't be put into practice via the predefined input fields that are
displayed in the column header. For example, you can't formulate anyOR conditions,
or define data filters for documents that are contained in a sample folder. Complex
data filters do not have these limitations.
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For example: You only want to see the images in a sample folder, all other document
types are to be hidden.

1. Switch to the Document View and select a sample folder, if you want to filter the
documents in the database that apply to this sample.

2. Use theDatabase > Define Filter... command.
l TheDefine Filter dialog box appears. You define the filter criteria here. It shows
the data filter that was last applied.

3. Determine in theSearch for group for which record type the data filter is to be
valid. Here, select the Image check box only.
l Which type of record will be offered depends on the current view.When you
are in the Document View, for example, the record typeProjectwon't be
offered, since in the Document View, no projects are displayed.

4. When you simply only want to see all of the images in the sample folder, you don't
need tomake any further entries in theConditions group.
You can, of course, additionally define one or more filter criteria in theConditions
group. You can, e.g., have only those images of the sample displayed that were
acquired by a certain user.

5. Click theSearch button to close theDefine Filter dialog box and to apply the data
filter.
l In the Gallery View, now only the images that fulfill the filter criteria set will be
displayed. All other types of document, e.g., workbooks, will be hidden.

Applying complex filter types once or repeatedly
There are several ways in which you can work with data filters.

1. If you need a data filter only once, use theDatabase > Define Filter... command to
define the filter and apply it immediately.

2. If you want to use a data filter repeatedly, save the data filter and use it in the
Project Filter View, or the Document Filter View.

Working with a filter view
1. Use theDatabase > Define Filter... command.
2. You define the filter criteria in theConditions group.

From the Field picklist, select, e.g., the [Project Status] database field.
In theCompare column, select the comparison operator. Select, e.g., the
comparison operator "contains".
In theValue picklist, select the entry "(Variable)".

3. Save the data filter. To do so, click theSave Filter Definition button.
l TheSave Filter Definition As dialog box opens.

4. Give it a descriptive name, so that you and other users will be able to easily
recognize the filter criterion. Give the new data filter the name "Project status" for
example.

5. Close all dialog boxeswithOK.
l You have then saved a data filter that you can use in the Project Filter View.
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6. Make sure that the project filter view is on display. That is the case when the
Show/Hide Filter View button appears clicked. You can find this button on the
Database tool window's lower toolbar.

7. Select the newly defined data filter from the list next to theSearch button.
l Then in the Project Filter View, all of the filter criteria will be displayed that have
been defined for the selected data filter. In this example, the filter criterion
"Project Status contains" has not yet been fully defined.

8. Complete a variable filter criterion by entering a value in the input field, e.g.,
"finished".
l Then the filter has been completely defined.

9. Click theSearch button.
l The project list will then be filtered. Only the projects that fulfill the filter criteria
you have set will be displayed.

3.3.3. Grouping records
In many cases, you will be able to group the records in the Project List View or in the
Sample List View in such a way that you will be able to reach the records you're
interested in with only a few clicks. For example, you can group the samples in a
project by their method of investigation.

On the left-hand side, you'll see a list view of the database. All of the recordswill be
arranged in the sameway, one under the other. On the right-hand side you'll see the
list view after the records have been grouped according to the criteria in a database
field. The records are now assigned to a group that is displayed in a tree view.When
you shut all of the groups, the display is, as a rule, more clearly laid out than it is without
being grouped.

Grouping records
1. Switch to the view in which you want to group the records. It is possible to group

records in the Project List View or in the Sample List View.
2. Right click on the header of the column bywhich you want to group.

l A context menu opens.

l You can group by any database field you wish. However, a grouping only then
makes sense, when the database field doesn't allow toomany different entries.
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When for every record, another entry in a database field ismade, as it is e.g.,
for the [Record Name] or the [Insertion date] database fields, grouping
according to this database field doesn't lead tomore clarity.

3. Select theGroup by this Field command.
l The grouping takes place. The recordswill then no longer be displayed in a list,
but instead in a tree view.
All of the records have then been allocated a particular group criterion, e.g., the
database field "Operator". Every field entry produces a superordinated entry in
the tree view, e.g., "Operator: Mr. Smith". To expand the entries belonging to a
particular criterion, click the small plus sign in front of the criterion.

l The number of groups after the grouping has been carried out, corresponds to
the number of different entries there are in the database field used for the
grouping action. When you, for example, allow the three entries "In Progress,"
"Postponed" and "Finished" for the [Project Status] database field, three
groupswill be generated. Every record will, depending on the project status, be
sorted into one of the groups.

4. If you want to, you can sort the grouped records in ascending or descending
order.

Canceling a grouping that has been set
1. Switch to the view in which you want to cancel the grouping. It is possible to group

records in the Project List View or in the Sample List View.
2. Right click on the header of the column bywhich records are currently being

grouped.
If you don't know what records are currently being grouped by: The database field
that is being used as group criterion will always be specified in the tree view.
l A context menu opens. TheGroup by this Field commandwill be indicated by a
check-mark when this database field is currently being used as the group
criterion.

3. Select theGroup by this Field command to remove this grouping.
l The tree view will be canceled and the records oncemore displayed in a list.

4. You can also cancel all of the groupings simultaneously. To do so, right click on
any column header and select theUngroup Table command from the context
menu.

Creating a multi-level grouping
1. Group the records. Choose as a group criterion, e.g., the database field

[Operator].
2. Right click on the header of an additional column bywhich you want to group.

Choose as a group criterion e.g., the database field [Method of investigation].
l The recordswill then initially be grouped by the operator. All of the records that
belong to the same operator will then be oncemore grouped by themethod of
investigation.
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3.3.4. Examples for data filters
Here, you will find examples for possible data filters. You can at any time also use a
data filter for a database search.

The way to write it
A data filter contains one or more filter criteria. You formulate a filter criterion in the
followingmanner:

( [Database field] comparison operator 'Field entry' )

Database fields are specified in square brackets, field values in inverted commas. As
comparison operator, the operators that are specified in theDefine Filter dialog box
are used.

Please note that the data filters specified here are only examples. In your database
other database fieldsmay be defined.

Data filter Filter results

[Preparation] equals 'thin section' All of the records in which the term 'thin section'
has been entered in the [Preparation] database
field. Should the field entry not be 'thin section' but
instead e.g., 'thin', the record will not be displayed
with this data filter.

[Insertion date] >= '03.03.2007' All of the records that have been inserted since the
3rd. of May 2007.

[Child Count] <> '0' When you use this data filter in the database's
Project View, all of the project folders to which
additional data has already been added will be
displayed. All project folders that are still empty will
be hidden.

[Insertion date] >= '03.03.2007'
AND [Insertion date] < '01.05.2007’

All of the records that have been inserted between
the 3rd of March 2007 and 31st of May 2007.

[Comment] contains 'untreated' All of the records that contain the word "untreated"
in the image comment. The word "untreated" can be
anywhere in the image comment. The complete
image comment text will be browsed.

[User] equals 'Mr Smith'
AND [Project] equals '340698’

All of the records that Mr Smith has inserted in the
project 340698.

[User] equals 'Mr Smith'
OR [User] equals 'Mr Jones’

All of the records that Mr Smith andMr Jones have
inserted in the database.

[Project] equals 'Project A' AND
( [User] equals 'Ms Thompson' OR
OR [User] equals 'Ms Richards' )

All of the records concerning the project A that the
users Ms Thompson andMs Richards have
inserted into the database. The brackets are
essential in this case.

Without the brackets, the system would show all of
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the records that Ms Thompson has inserted into the
database concerning project A, and additionally, all
of the records user Ms Richards has inserted into
the database, and not only those concerning project
A. The reason for this is that, without brackets, the
logical AND operator will be taken into account
before the OR operator.
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3.3.5. Database search / Data filter
Aswell as the possibility of searching for data in your database, you can also filter data
in a specific database view.What is the difference between a database search and a
data filter?

The database search differs from the application of a data filter in the following points.

Database search Data filter

Which data are affected? A database search will
always be conducted
through the whole
database.

A database filter always
relates to the current
database view.

Examples Youwant to view all of the
images that are contained
in two different projects.

TheDatabase > Define
Search... command is
available in every database
view. This means that you
can formulate the
appropriate search
definition in your
database's Project View,
and carry out the search.

In the Project View, a data
filter always applies to the
project folder on display.
You can, e.g., have only the
projects displayed that
have the project status,
"open".

In the Document View, a
data filter always applies to
documents contained in the
sample folder that has been
selected.

TheDatabase > Define
Filter... command isn't
available when you're in
your database's Search
Results View.

Where will the results be
displayed?

You will find the results of a
database search in a
special database view, the
Search Results View.

A database filter hides
records in the current
database view.

How do I cancel a database
search or remove a data
filter?

The data in the search
results view will be
automatically overwritten
by a new database search.

Use theDatabase >
Remove Filter command to
remove the active data
filter. Then all of the records
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will be displayed once
more.
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3.4. Searching for records
You can search for data in your database at any time you want to. When you search
through a database, please pay attention to the following points.

l Youmust define search conditions if you want to find records.
l Youwill find the results of a database search in a special database view, the
Search Results View.

l Each new database search overwrites the results of the previous search.

Different search possibilities
There are always two ways to search for records.

l Searching directly for a record
If you only need a search definition once, specify the search condition with the
Database > Define Search... command, and apply it directly.

l Searching in the Search View
If you want to use the same search definition repeatedly, save the search
definition and used these saved search definition in the Search View.

Searching the entire database for text
You can search for text directly in your database without first having to define a search
definition. In a full text search, all entries in all database fields with the data type Text or
Memowill be searched.
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3.4.1. Searching directly for a record
1. Use theDatabase > Define Search... command.

l TheDefine Search dialog box opens. You define the search conditions here.

l You can use theDefine Search dialog box in every one of your database's
views. That's to say, you can also search for images in the database's Project
View, or inversely, search for projects in the Document View.

2. In theSearch for group, you can limit the search to a few record types. You can,
for instance, only search for images or for projects.

3. Define one or more search conditions in theConditions group.
4. Click theSearch button to start the database search.

l Your software will switch automatically into the database's Search Results
View. Here, only the records that fulfill the current search conditionswill be
displayed.

This is how you can search directly for records:
Open theDefine Search dialog box. To do so, click, e.g., theDefine Search button (1).
In theDefine Search dialog box, define the search conditions, then click theSearch
button (2) carry out the search.
The search results will be displayed in your database's Search Results View (3).

Exiting the Search Results View
There are several ways to leave the Search Results View.

1. Select a record in the Search Results View.
Click your right mouse button and select theGo ToRecord command in the
context menu.
l Your software will then automatically display the sample or the project to which
the record you've selected belongs. To do this, your software will automatically
switch to the appropriate database view.

2. Click theShow Projects button to switch to the Project View of the database. You
can find this button on theDatabase tool window's lower toolbar.

3. Click theShow Documents button to switch to the Document View of the
database. You can find this button on theDatabase tool window's lower toolbar.

OLYMPUS Stream Database User Manual 57



3.  Working with a database
3.4.   Searching for records

3.4.2. Searching in the Search View
In the step-by-step instructions that follow, it will be assumed that search definitions
that have been saved already exist. Should this not be the case, you can find step-by-
step instructions on how to create and save a search definition further below.

1. Click theShow Search Results button to switch to the Search Results View of the
database. You can find this button on theDatabase tool window's lower toolbar.

2. Make sure that the Search View is on display. That is the case when the
Show/Hide Search View button appears clicked. You can find this button on the
Database tool window's lower toolbar.

3. Select the search definition you want from the list next to theSearch button.
l In the Search View, the search conditionswill then appear.

4. Make the necessary entries for the variable search conditions. These are, as a
rule, different for every database search.
l Theway you have tomake the entries can also vary. Youmay be offered a
picklist, or a calendar field will appear in which you can select a date. Should
you be searching for a note, youmay in certain cases have to enter the note
you're looking for (or a part of it) manually.

5. Click theSearch button.
l The search will be carried out. As a result of the database search, all the
records that fulfill the search conditions you've set will be displayed.

l When a database search has been carried out, the number of records that
have been found will be shown at the bottom left-hand side of the database
window.
Themessage "26 of 12000 records" means, for example, in the Project View,
that the database contains a total of 12,000 projects, of which 26 fulfill the
search conditions.
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Use variable search conditions to search for records in your database's Search Results
View (1). Display the Search View (2). Choose the search definition (3), define the
search condition (4), then carry out the search (5).

3.4.3. Specifying the search conditions for a database search
1. Use theDatabase > Define Search... command.

l TheDefine Search dialog box opens.

2. Specify in theSearch for group which type of record you want to look for.
3. Define the first search condition in the first line of theConditions group.

l As soon as you have completely defined the first search condition, an additional
line appears for an additional search condition.

l When you want to use the search definition in the Search View, you should, if
possible, use variable search conditions. For example, specify the following
search condition:
[Record Name] contains "(variable)".
Then you can very easily search for whichever record names you want in the
Search View.

4. If necessary, define an additional search condition in the second line. In this case
you will have to specify the logical link between the two search conditions.
To do this, select one of the logical operators AND or OR in the line's first field.
l With the logical operator AND, both of the search conditionsmust be fulfilled
simultaneously, in order for a record to be found with this database search.
With the logical operator OR, only one of the two search conditions has to be
fulfilled in order for a record to be found.

5. Save the search definition. To do so, click theSave Search Definition button.
l TheSave Search Definition As dialog box opens.

6. Give it a descriptive name, so that you and other users will be able to easily
recognize the search definition.

7. Click theSave button to save the search definition.
l TheSave Search Definition As dialog boxwill be closed, and you'll return to the
Define Search dialog box.

8. Close theDefine Search dialog box.
9. Switch to the Search View and try out the database search.
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3.4.4. Dialog box - Define Search
Use theDatabase > Define Search... command to define search conditions for a
database search.
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(1) Limiting your database search to certain types of record
(2) Defining search conditions
(3) Saving, loading and deleting search definitions
(4) Finding child records

(1) Limiting your database search to certain types of record

You can selectively search for specific types of record. In theSearch for group, all of
the record types that have been defined in the current database will be listed. This
means that, depending on the database, you can find different entries there.
Select the check box in front of every type of record that is to be taken into
consideration during the database search.

Searching solely for images
For example: You are looking for a specific image. You know that the image was
inserted into the database after the 1st July 2013.

1. Use theDatabase > Define Search... command.
l TheDefine Search dialog box opens.

2. Click theDeselect All button in theSearch for group.
l All of the check boxes in theSearch for group will be cleared.

3. Select the Images check box.
4. Define the following search condition in theConditions group.

[Creation Time] >= '1.7.2013 00:00'
l Note: You can only enter search conditionswhen at least one record type has
been selected in theSearch for group.

5. Click theSearch button to start the database search.
l Your software will switch automatically into the database's Search Results
View. There, you can find all of the images that were inserted into the database
after the 1st July 2013.
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l Only imageswill be searched for. The database search finds no other types of
record,for example no workbooks, database folders or report instructions.

(2) Defining search conditions

You define the search conditions for a database search in theConditions group. There
you can formulate very simple search definitionswith only one search condition, as
well as very complex search definitions that aremade up of several search conditions.

Defining a simple search condition

You define a simple search condition in the followingmanner:

( [Database field] Comparison operator 'Field value' )

To define the search condition, you have to fill in the fieldsField,Compare, Value and
Unit. To do this, in theDefine Search dialog box, click in the appropriate field, in the
table in theConditions group. As soon as you have clicked on one of the fields, a
picklist with a range of possible entries for this field opens.

Field Compare Value Unit

Field
The Field picklist contains all of the database fields that have been defined for the type
of record you have selected. Select a database field to search for entries in this
database field.

The database fields in the Field picklist are arranged in alphabetical order. You can
make the search easier: To do so, click in the field and enter the initial letter of the
database field you are searching for. Then the first database field with a name
beginning with this letter will automatically be displayed.
Then use your keyboard's arrow keys to browse through the database fields. You
begin with the database field that is on display.

Example: Select the [Creation Time] database field when you're interested in images
that were acquired before or after a specific date.

Compare
TheCompare picklist contains comparison operators for search conditions.Which
comparison operators will be offered, depends on the data type of the database field
that has been selected.

Example: A database field of the Integer data type offers the comparison operator <>.
The comparison operator [<>] stands here for "not equal to".
Limit your search to the Image record type. The search condition ( [Bit Depth] <> '8' )
searches for all of the imageswith another bit depth than 8 bit, e.g., for 24-bit true-
color images.
Restrict the search to the record typeProject. The ( [Child Count] <> '0' ) search
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condition will then look for all of the projects for which samples have already been
inserted. Since only for these projects is the child count not equal to 0.

Value
Enter the concrete field value that is to be used in the database search, in theValue
field. Should a picklist have been defined for the selected database field, you can find
all of the entries of this picklist in theValue list.

In theValue field you will also find the options (Blank) and (Variable). You can find
more information further below.

For example: In the database, the database field [Preparation] has been defined.
When a record is inserted, you enter which preparation has been used, and in this way
specify the value for the database.
The search condition ( [Preparation] equals 'thin section' ) then searches for only the
samples that have been prepared as a "thin section".

Unit
TheUnit field will be automatically filled out when a unit has been defined for the
database field that has been selected.

For example: For the [t Spacing] database field, a unit of time e.g., seconds, will
always be defined. The database field shows, where a time stack is concerned, the
time interval between two frames.

Defining a variable search condition

You define a simple search condition in the followingmanner:

( [Database field] Comparison operator 'Field value' )

What is a variable search condition?
When you define a search condition, you can either define a concrete value or leave
the value as a variable. Where a variable search condition is concerned, the user has
to add the concrete value for which the search is to be carried out, before the database
search can start.

How do you define a variable search condition?
You define a search definition in theDefine Search dialog box, in theConditions
group. If you don't make a concrete entry in theValue field, or select one from the
picklist, but instead, select one of the entries (Blank) or (Variable), you will have
defined a variable search condition.

How do you use a variable search condition?
A variable search condition can, just as every other search condition, be used in the
Database tool window's Search View.

When do you apply variable search conditions?
Generally speaking, it makes sense to use variable search conditionswhen you want
to use a database search repeatedly.
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Example:
Let's suppose that in your database, the database field [Project Status] has been
defined.When you use variable search conditions, you need only once define a search
condition if you want to make a quick search for projects with an arbitrary status. This
search condition reads:
( [Project Status] equals '(Variable)' )

If you don't use a variable search condition, you will have to define an individual
database search for each and every project status, that's to say, ( [Project Status]
equals 'closed' ), ( [Project Status] equals 'running' ) etc In this case you'll need at least
3 saved search conditions, if not more.

Defining a database search with several search conditions

In theDefine Search dialog box, you can formulate very complex search definitions for
a database search.

How do you define several search conditions?
As soon as you have completely defined the first search condition, an additional line
will appear in the dialog box, for a new search condition.

A search definition that contains two search conditions is defined as follows:
( [database field1] comparison operator 'field contents1' ) <logical operator> ( 
[database field2] comparison operator 'field contents2' )

Using the logical operators AND and OR
Two search conditionswill be linked by either the logical operator AND, or by the
logical operator OR.
Select the logical operator you want in a line's first field.

Select the logical operator AND to search for all of the records that simultaneously
fulfill all of the search conditions.

Example: You are looking for records that Ms. Miller inserted into the database in
2012. Define the following search condition:
( [user] equals 'Miller' AND [insertion date] > '31.12.2011' AND [insertion date] <
'1.1.2013' )

Select the logical operator OR to search for all of the records that fulfill at least one of
the search conditions.

Example: You are looking for all Z-stacks or time stacks. Define the following search
condition:
( [number t-layers] > '1' OR [number Z-layers] > '1' )

Using brackets
When you use several search conditions youmay, in certain cases, need to use
brackets. Set the brackets around the two search conditions that are first to be
evaluated.Without brackets, the logical AND operator will be taken into account
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before the OR operator.

Deleting individual search conditions
In theConditions group, select the search condition you want to delete. Click the
Delete Condition button in theConditions group to delete the line with the selected
search condition from the search definition.
Should you want to delete all of the search conditions, in order to begin defining the
database search from scratch, click theDelete All Conditions button, located at the top
the dialog box, immediately below the title.

(4) Saving, loading and deleting search definitions

Use the zoom buttons in the dialog box to save, load, delete or manage search
conditions.

(4) Finding child records

Select the Find child records check box, to search for recordswithin specific database
folders. To do so, define a search condition for the database folder to receive all
recordswithin the found database folder in your search results.

This enables you to e.g., implement the following search conditions in your database:

For example: Let's suppose that your database contains the structuring record type
Project. You now want to find all of the images that have been inserted into the
database and belong to the projects "P01_2011", and "P02_2011".

1. In theSearch for group, select only the Image check box, so that only imageswill
be found.

2. Select the Find child records check box.
l Your software will automatically delete all currently defined search conditions.

3. Define the following search condition:
[Record name (Project)] equals "P01_2010"
OR [Record name (Project)] equals "P02_2011"
l The search results contain all of the imageswhich have been inserted to the
project "P01_2010".
The projects themselves are not contained in the search results.
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3.4.5. Find Text in Database
You can search for text directly in your database without first having to define a search
definition. In a full text search, all entries in all database fields with the data type Text or
Memowill be searched.
You can find the full text search functions in the lower toolbar in theDatabase tool
window.

Entering search terms
When entering search terms, note the following points:

l You can enter more than one word. In that case, the database searches for all
recordswhere both terms are used.

l You don't have to enter the complete word. For example, enter the text "chemi".
Your database will now find all records in which the words "chemical" or
"chemistry" are used.
In this way, the entry "alumin" is sufficient to find "aluminium".

l The full text search isn't case sensitive.
l Avoid using special characters, for example # or &.

Example: You want to find all recordswith the keyword "Aluminium oxide" used within
any of the database fields.

1. Make theDatabase tool window appear.
l There is a field (1) where you can enter text in the tool window's toolbar. If you
have not yet searched for any text, Enter text herewill appear in the field.

Entering search terms
2. Enter the search terms into the search field (1). In this example, enter "Alumin".

Limiting your full text search to certain types of record
3. You can limit the full text search to certain record types. You can, e.g., only search

for images. Click the small arrow next to the Find Text in Database button to open
amenuwith commands you can use with full text search.

4. Select theSelect Record Types... command.
l TheSelect Record Types dialog box appears. Here, all of the record types that
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have been defined in the current database are listed. Thismeans that,
depending on the database, you can find different entries there.

5. Select the check box in front of every record type that is to be taken into
consideration during the full text search.
Clear the check box in front of every record type that is to be ignored during the full
text search.

6. Close the dialog boxwithOK.
l When you excluded several record types, the appearance of the Find Text in
Database button changes. Then the button will look like this:

Starting the full text search
7. Click the Find Text in Database button to start the full text search.

l Before the full text search begins, your software automatically checkswhether
the full text search has been activated on the database server. If the full text
search hasn't been activated on the database server, the searchmay take a
long time. In this case amessage appears and you can still cancel the full text
search.

l The full text search is carried out. The search will return all records in which the
word "aluminium" appears in any database field of the data typesText and
Memo.

l The search results are shown in the Search Results View.

Note: You won't be shown in which database field the searched termwas found.
Because it is searched in every database field, it is possible that the database field with
the searched text is not shown in the current database view.
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3.5. Selecting records
Before you can load, move, or delete records from the database, you have to select
the records you want in the database.

Selecting database folders
In some database views, database folders are displayed. There are, as a rule, several
records in a database folder. In your database's Project View, you'll find, for example,
project folders that contain sample folders with images and other documents. All of the
records that are below the selected database folder are also selected when you select
a database folder.

Please note: When you select a record below which a large number of other records
are arranged, then subsequently use, e.g., theDelete Record command, all of the
documents below the selected database folder will be deleted.

Selecting several records
In most of the database views, you can select several records simultaneously.
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For the selection the standardMS-Windows conventions for multiple selection are
valid.

l You can select individual records that aren't arranged consecutively. To do so,
hold the [Ctrl] key depressed and click the records you want.

l You can select a row of records. To do so, hold the [Shift] key depressed and click
on the first and last record that you want to select.

Selecting several records out of the results of a search.
Should the records you want to select be contained in different database folders, first
define a database search that will include all of the records. For example, search for all
of the imageswhen you want to select specific images.When you carry out the
database search, the search results will automatically be displayed in the Gallery
View. Here, you can select the records you want.

00329 28062011

3.6. Loading documents

3.6.1. Overview
To load documents out of a database into your software, use the Load Documents
command. A document can be an image, but also a report instruction, a chart, or
another document.

Before using the command
Switch to your database's document view. Select the documents you want to load in
the database gallery.

Accessing the command
There are several ways of accessing this command:

l Click the Load Documents button. You can find this button on theDatabase tool
window's upper toolbar.

l Use theDatabase > Load Documents command.
l You can also find the Load Documents command in the context menu for the
database gallery.

What will happen...
l Your software will switch automatically from the "Database" layout into the
"Processing" layout.

l Should your software be able to load the selected documents, theywill be loaded
into the document group. Every document will be allocated its ownwindow in the
document group. Click the title of a document to have that document displayed.

l To load an image, the image data has to be requested from the File Server and
transferred to your database client. Depending on how quick your network
connection is, on how large the image is, and which document storage type you
use, loading an image can take quite some time.
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When do you have to load documents?
l Your software supports a variety of image types. Please note that the image
preview doesn't allow you access to all of the image information. For example, you
won't be able to view the individual frameswithin a time stack separately. If you
want to view the image inmore detail, load it into the document group.

l Youwill need to load an image from the database when you want to process an
image from a database. Typical processing includesmeasuring or using filters.

You can also view images in their full resolution in theDatabase tool window. To do
so, you don't have to load them separately in the document group. To do so, use the
Document/Live-image View.

Loading document types that are not supported
Some documents can't be viewed in the database. For example, reports or files from
other application programs such as, e.g., DOC and XLS files, will be displayed as an
icon in the database gallery. These documents will have to be loaded if you want to
view them.
If you load these files, the respective application program e.g. MS-Word or MS-Excel,
will automatically open, should the application program have been installed on your
PC.

Should the appropriate application program not have been installed on your PC, you
will receive amessage to this effect.
In this case, select the document in the Gallery View, then right click and use theOpen
With command from the context menu. Your programwill offer you all of the programs
with which the document type can be opened.
Alternatively, you can export the document and view it on another PC onwhich the
corresponding application program has been installed.
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3.6.2. Loading documents from a database
There are several ways in which you can load data from a database into your
software:

l Use theDatabase > Load Documents command.
l Drag one or more documents, e.g., from theGallery View byDrag&Drop into the
document group. You can only use this possibility when the database window
hasn't beenmaximized, and the document group and database window are
opened at the same time.

l You can set up your software so that you can also load the documents by double
clicking in the document group. To do this, open the Tools > Options > Database >
General dialog box. From theWhen a document record is double-clicked list,
select the Load the Document entry.

This set of step-by-step instructions is only one example. There are several ways in
which you can load documents.
You will find notes on this, e.g., in the descriptions of the various database views.

1. Switch to your database's Document View, and select a sample folder.
l In the Gallery View, you will now see all of the documents that are to be found
under the selected record. Imageswill be shown as thumbnails, other
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document typeswill be shown as icons.
l You can also load documents which are the results of a search.When, for
example, you want to load all of the images that were acquired with a specific
microscope, define a search definition using thismicroscope's name. The
images found will be displayed in the Gallery View. There, you can select the
images you want.

2. Select the thumbnails or icons for all of the documents you want to load.
3. Click the Load Documents button. You can find this button on theDatabase tool

window's upper toolbar.
l When your software can open a document, it will be displayed in the document
group.

l Your software will switch to theProcessing layout.

l If your software can't open the document, the appropriate application program
is opened and the selected document is loaded into this program.
Should the appropriate application program not have been installed on your
PC, you will receive amessage.
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3.7. Editing records in a database
There are several ways in which you can edit records after you have inserted them into
the database.

Note: If you have the software version "Olympus StreamEnterprise", not every user
has the right to edit records. Apply to your database administrator when you want to
change your user rights.

Changing and adding to entries in database fields
When you set up a record, you already have tomake entries in themandatory fields.
You can change, or add to entries in the database fields at any time.
An exception to this rule are the database fields that are automatically filled out, such
as the record name. These database fields can't be edited.

1. Select the record you want to edit or to add to the contents of its database fields.
You can select records in the Project View or in the Document View. In the
Document View you select either a sample folder in the Sample List View, or a
document in the Gallery View.
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In your database's Document View you have access to sample folders and documents.
Select a sample folder in the Project List View (2). The Document Info View (1) will then
show you the information that has already been entered in the database fields for this
sample.
Select a document in the database gallery (3). You will now see the information related to
the selected document in the Document Info View.

l The Project Info View or the Document Info View shows you the information
that has already been collected for this record. If all of the fields that you want to
edit aren't shown there, you can customize this view.

l Mandatory fields will be displayed in extra bold type. You can change the
contents of these fields, but the fieldsmust not remain empty.
Fields whose content may not be changed (e.g., [Creation Time]) will be
displayed with a gray background.

2. Add to or change the entries relating to the record. Which fields you can edit, and
which you can't, depends on your database's structure.
l As soon as you have changed an entry in a database field, the two buttons in
the Record Details View's toolbarConfirmChanges andAbort Changeswill
become active.

3. Click theConfirmChanges button to have your changes adopted.
Click theAbort Changes button if you decide not to make the changes in the
contents of the database fields.
l The record will be changed when you have confirmed the changes.

Changing entries in database fields without an inquiry
1. Add to or change the entries relating to the record.
2. Finalize the editing of the database fields for this record. To do this, select, for

example, the next record.
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l Your software will then open a dialog boxwith the inquiry whether or not the
changed values are to be adopted.
In this dialog box, you'll find theDon't askme again check box.

3. Select theDon't askme again check box.
l You can then change entries in database fields without having to confirm these
changes. Altered entries will then be automatically saved in the database, as
soon as you, e.g., select another record.

4. You can switch this inquiry back on. To do this, use the Tools > Options...
command. Select theDatabase > General entry in the tree view. Select theAsk
before saving record changes check box.

Processing the documents from a database
You can, at any time, load, and edit a document that has been saved in a database,
then insert it back into the database.

Note: The following step-by-step instructions don't apply to external documents.
External documents are documents of a type that can't be loaded into your software,
e.g., MS-Excel documents.

Specifying how your database is to behave when changes are made to
documents
1. Use the Tools > Options... command. Select theDatabase > General entry in the

tree view.
l In theSaving loaded document group, you specify how your software is to
behave when you have changed a document that has already been saved in a
database.

2. Choose theAlways askwhat to do option.

Editing a document from a database and reinserting it
3. Load an image from a database. To do this, select the image and use the

Database > Load Documents command.
l The image will now be shown in the document group.

l Your database will then automatically switch into the "Processing" layout.

4. Process the image in your software. Your software offers you numerous
possibilities for doing this. Here are a few examples:
l For example, use the commands in theProcessmenu to optimize the image
contrast.

l Use the buttons in theDrawing toolbar to label the image.

l Use the commands in theMeasuremenu tomeasure objects on the image.

5. When the processing is finished, close the image in the document group. To do
this, use e.g. the [Ctrl + W] shortcut.
l A dialog box offering several possibilities opens. You can replace the original
document in the database, insert the processed document as a new record, or
save it as a file in any directory you want.

OLYMPUS Stream Database User Manual 71



3.  Working with a database
3.8.   Moving recordswithin a database

6. From the dialog box's list, select, e.g., thePaste entry, then confirm this withOK.
l The altered document will then be inserted into the database, and will replace
the original document. When this is done, the original document will be
overwritten.

l The information from the database fields will be adopted from the original
document without any inquiry beingmade.

l Your software retains the information that the document was loaded from a
database, even if this database was then closed after the loading of the
document was completed. In this case, your software will automatically open
theOpenDatabase dialog box.
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3.8. Moving records within a database
You canmove existing recordswithin your database.
When youmove images or other documents, there are two very different tasks that
are related to themoving.

l You canmove images and documents into another database folder. By doing this,
you change the actual contents of some database fields that are linked to the
record. Images and documents that have beenmoved will be displayed at another
position in the user interface. The actual document files won't be changed in this
process.

l The database administrator canmove images and documents to another
document directory. This also changes the storage location for the documents.

Example: Should you have inadvertently inserted records into a false database folder,
you canmove them from there to the correct folder.

Moving documents by using commands from the context menu
1. Select the records you want to move.

l You can select the records in different database views.
Switch to your database's Document View and select the documents in the
database gallery.
Alternatively, you can also search for the documents that you want to move.
Then select the documents in the Search Results View'sGallery View.

l In the Gallery View, you can select several documents simultaneously. To do
so, keep the [Ctrl] key pressed while you select the documents.

2. Click the right mouse button to open a context menu. From the context menu,
select theCut command.

3. Select the record into which you want to insert the document.
l You have to always select the record that is located one hierarchy level higher.

l When your database is based on the database template that is provided, you
can only insert images and documents into a sample folder.

4. Click the right mouse button to open a context menu. Select thePaste command
from the context menu.
l The record ismoved.
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Note: Use thePaste andCut commands from the context menu aswell to move
sample folders to another project folder.

Moving records by Drag&Drop
Alternatively, you can alsomove a record byDrag&Drop. Let's assume that several
sample folders belong to a project. You want to move one image from one sample
folder to another.

1. In your database's Project View, doubleclick the sample folder.
l Your software will switch to the Document View. There, you can see the
sample folders that belong to the chosen project.

2. Select the sample folder that contains the documents you want to move.
3. Select the documents you want in the Gallery View.
4. While keeping your left mouse button depressed, drag the document onto the

sample folder into which you want to insert it.

The illustration shows theDatabase tool window in the Document View. The sample
folder (1) has been selected, and theGallery View shows the documents that are in that
sample folder. Tomove the image, drag it, while keeping your left mouse button
depressed, (2) onto the sample folder (3).

l Your software opens a dialog boxwith an inquiry.

5. Confirm the request.
l The document ismoved. The document disappears from theGallery View.

6. Select the sample folder into which you havemoved the document.
l Then you'll see the document you'vemoved in the Gallery View of its new
sample folder.
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3.9. Importing and exporting data

Exporting a database's structure
It canmake sense to export a database's structure in order to use the database export
file (DBE file) that has been created as a template for a new database that is to have
the same structure.
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1. Open the database whose data structure you want to export.
2. Select a layout in which you will be able to display several tool windows. Use, e.g.,

theView > Layout > Processing command to switch to theProcessing layout.
3. Use theDatabase > Import/Export > Export Database... command.
4. Assign the DBE file a name.
5. Specify the location at which the DBE file is to be saved.
6. In theOptions group, select which data are to be exported from the database.

Select, e.g., theExport structure only (database template) option when you want
to create a template for a new database.

7. Click theOK button to start the export.
l The Logging tool window will automatically appear. Here, you will see which
data are currently being exported.

l When the export has been completed, amessage boxwill appear. Additionally,
you can see a correspondingmessage at the end of the list, located in the
Logging tool window.

8. Close themessage box.
l With that, the export has been completed. You can then carry on working with
the current database as usual.

9. Use theDatabase > New... commandwhen you want to set up a new database
on the basis of the exported DBE file.
l You can findmore information on setting up a new database here.

Importing a database into a new database
You can import data from another database into your database. The prerequisite for
this is that both databases have the same database structure.

1. Use theDatabase > Import/Export > Import Database... command.
l The Import Database dialog box opens.

2. Click theBrowse... button, and navigate to the directory in which the DBE file
(Database export file) is located.

3. Select the data you want to import.
l Select e.g., theExport structure, users, and structuring records option. Now,
the complete contents of the DBE file will be imported (that means, also
documents, should the DBE file contain documents).

4. Click theOK button to start the import.
l The Logging tool window will automatically appear. Here, you will see which
data are currently being imported. The importing process can, when
documents are also imported, take some time. Therefore, keep an eye on the
information in this tool window.When the importing process has been
completed, you will see a correspondingmessage at the end of the list located
in the Logging tool window.

l The current database now also contains all records from the imported
database.
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5. Use theView > Layout > Reset Current Layout command in order to display only
toolbars which are normally shown in the database layout.
l You can then continue to work with this database.

Exporting documents from a database
You can export individual documents from a database. In this way, you can, e.g., make
images available to users who have no access to the database.When you export a
document, youmake a copy of it. Thismeans that the original documents in the
database will be retained.

1. Select the records you want to export.
2. Use theDatabase > Import/Export > Export Documents... command.

l TheExport Documents dialog box opens.

l Keep an eye on the display at the bottom of the dialog box. It shows you the
amount of data that is going to be exported.

3. Make the required settings in this dialog box. The grayed out functions don't apply
to your database version.
l Select theReproduce database structure in file system check box tomaintain
the record's hierarchical structure. A directory will be set up on the hard disk for
every database folder in which there are files. This directory's name is also the
name of the record.

l Click the [...] button next to theDestination path field to choose the directory
into which the data you export is to be saved.

4. Click theOK button to start the export.
l The export begins.

l When the export has been completed, amessage box appears.

l Youwill find the exported data in the specified destination directory.

l The exported documents in the database remain unchanged.
00320 27062017

3.10. Delete Record
Use theDatabase > Delete Record command to delete all records you have selected
from the database. The recordswill then bemoved to the recycle bin of the database.
You will receive a corresponding warningmessage.

Before using the command
Select one or several records.

Accessing the command
There are several ways of accessing this command:

l Click theDelete Record button. You can find this button on theDatabase tool
window's toolbar.
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l Right click the database view that you have selected the records in. Select the
Delete command from the context menu.

l Use theDatabase > Delete Recordmenu command.

What is then deleted?
When you delete a record, you will also lose all of the information that has been
entered on this record in the database.

When it is deleted, all of the documents belonging to this record will be automatically
deleted, too. That's to say, when you delete a database folder with images and
documents, all of the images and documents in the database folder are also deleted.

No deletion of loaded documents is possible
You can't delete a document that you've loaded into the document group from the
database. You receive amessage when you try to delete the document.

First, close the document window in the document group, before you use theDelete
Record command.

5631

Recycle bin of the database
Use theRecycle Bin command to see all records available in the database's recycle
bin.

Accessing the command
There are several ways of accessing this command:

l Click theRecycle Bin button. You can find this button on theDatabase tool
window's toolbar.

l Use theDatabase > Recycle Bin...menu command.

TheRecycle Bin dialog box shows all records that have been deleted in the database.

For the currently selected record, you see all information that has been entered for this
record. With image records, a preview is displayed aswell, which allows you to zoom
into the image.

In theRecycle Bin dialog box, you can either restore or permanently delete all deleted
records.

Toolbar in the dialog box
The following table lists the buttonswhich are available by default on the toolbar.

Restore selected
database records

Click this button, for example, when you want to restore
records that have been deleted accidentally. You will
receive a corresponding warningmessage.

Permanently
delete selected
database records

Click this button to permanently delete all records that are
currently selected in theRecycle Bin dialog box. You will
receive a corresponding warningmessage.
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Permanently
delete all
database records
from the recycle
bin

Click this button to permanently delete all of the records that
are available in your database's recycle bin. You will receive
a corresponding warningmessage.

Toggle between
gallery view and
table view

Click this button to switch from the gallery view to the table
view and vice versa. In the gallery view, a thumbnail is
shown for every image.
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3.11. Close Database
Use theDatabase > Close commandwhen you've completed the work you wanted to
do with the current database. You will then no longer be able tomake use of the data
in this database, nor insert any new data in it.

The following actionswill close the database automatically.

l When you close your software, a database that has been opened will be
automatically closed.

l Since only one database can be open at a time, the currently open database will
be automatically closed when you open another one.

Please note though, that you do not close the database when you close theDatabase
tool window. You can, at any time, make the tool window reappear with the database.
To do this, use, e.g., theView > ToolWindows > Database command.

Software functions
Your software stays open after the database has been closed, enabling you to
continue working with its functions. Thismeans that, for example, you can load images
from your hard disk and process them.

5622
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4. Administrating the database
Which tasks are the responsibility of a database administrator?
Many of the tasks that have to do with the administration of a database can only be
made by the database administrator. For example, only the database administrator
can set up a database, assign user rights, or change the structure of a database.

Who can be a database administrator?
A database administrator must, on the SQL server, have the right to set up a
database.When this prerequisite has been fulfilled, every user of your software can
take on the role of the database administrator. When you installed theMicrosoft SQL
server, during the installation of your software, then you'll automatically have the
corresponding rights. Should you not have the necessary rights on the SQL server,
apply to the SQL server administrator.
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4.1. File storage in a database
When you set up a new database, you specify where the database files and the
images, (and other documents) are to be saved. The database supports two different
document storage types for images and other documents: File System andSecure
File Repository. If you use the File System document storage type, youmay end up
with a data distribution as shown in the figure:

Your software is installed on the database clients (1). The database clients
communicate with the database server.
The database and the databasemanagement system (DBMS) can be found on the
database server (2). Whenever documents are inserted into the database or loaded
from the database, the database server communicateswith the file server.
The document directories with images and other documents can be found on the data
server (3). On the database server, only a link to the document is saved.
Database clients, database servers, and file servers can also be located on one PC.

4.1.1. Database clients
The database clients are all of the PCs on which your software and an SQL-Client, or
Oracle-Client, have been installed. Your software offers (amongmany other
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functions), the user interface that enables you to communicate with the database
server. From the database client, you can set up new databases and access existing
databases.

For viewing, editing, or loading the requested data will be transferred to the database
client. Thismakes it possible for numerous database clients to have access to the
database at the same time.

4.1.2. Database server
On the database server, the databasemanagement system (DBMS) has been
installed.

Database file
On the database server lies, first and foremost, the actual database file. The database
file contains all of the information about the database structure, such as field tables
and saved search definitions.

Also, all records are contained in the database file. When you, e.g., insert an image
into the database, in doing so, you create a new record of the Image type in the
database. This new record will then be saved andmanaged in the database. The
database assigns this record an unambiguous name and saves all of the
corresponding information belonging to it (e.g., the insertion date, the file size or a
comment on the record). Themanagement of thesemetadata by the database
enables the user to search the database for records that meet the search criteria he
has specified.

Note: Images (or other documents) will not be saved within the database. Otherwise
the database file would becomemuch too large. The database file contains only the
reference to the place where the image has been saved.

4.1.3. File Server / Server for Secure File Repository
The database supports two different document storage types for images and other
documents: File System andSecure File Repository.
Where the document storage in a file system is concerned, images and other
documents will be saved in special document directories. When the Secure File
Repository storage type is used, images and other documents are located on a server
that has been set up for this purpose as a Secure File Repository (SRF).

You determine the document storage type when you set up a new database. This
can't be retroactively changed. It is, however, possible to work with several databases
that use different document storage types.

Checking access to documents
Nomatter what document storage type you have, it is important to make sure that the
PC where the documents in a database are stored, is always accessible. Should this
not be the case, you will receive an error message when you try to load a document
from the database.
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Document storage type "File System"
Where the document storage in a file system is concerned, images and other
documents will be saved in special document directories.

There are no particular requirements for the location of a document directory. They
can be located practically anywhere on the network. For example, the document
directory could be located on the database server itself. Of course, it is also possible to
set up a specific PC as a file server where all documents from the database are stored.

You can also distribute your documents over different file servers.
Use this possibility, for example, to increase the speed of data transfer when users
access the database from different locations.
An alternative use is to set up a document directory for documents that are no longer
used very often. By doing this, you can integrate especially safe, but slow, storage
media into your database to archive documents, e.g., streamers or magnetic tapes.

Use theSettings > Document Storage Type > File System dialog box tomanage your
database's document directories.

Please note: When you connect with the File Server you can view the document
directory in MS-WindowsExplorer. Always open all documents that have been saved
in the database, via the database, and not via theMS-WindowsExplorer! Also the
deleting or renaming of documents that are located in the document directorymust not
be done viaMS-WindowsExplorer, since in this case the database will not become
aware of these changes.

Document storage type "Secure File Repository"
Should you wish to save your documents especially safely and protected from
unauthorized access, you can acquire an additional software package that will provide
you with a Secure File Repository. This will be installed on the server for Secure File
Repository.

The software package is called SFR (Secure File Repository). This software package
ensures that all of the database's documents can only be opened and viewed via a
database client. There is no possible way for users without an authorization to open
the database. In MS-WindowsExplorer, directories that have been set up on the
server for Secure File Repository will not be displayed.
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4.2. Setting up a new database

Overview of the process flow when a database is set up
The following steps have to be taken when a new database is set up.

Setting up a new database

Define Database Structure
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Define Record Types

Setting up database fields
00327

4.2.1. New Database
Use theDatabase > New... command to set up a new database.
TheNew Database dialog boxworks in a similar manner to a wizard. It guides you
step-by-step through the setting up of a database.

Steps for setting up a new database
(1) Selecting a database server
(2) Entering the database name
(3) Selecting a database template
(4) Setting up a consolidated report and database

Before you set up a new database
To be able to set up a new database, you will have to comply with the following
prerequisites:

l Youmust have been logged on to a database client.
l The database server and the file server, i.e., the server for the Secure File
Depository, have to be available.
A separate file server is only needed if you want to save documents on a separate
PC. You can use any folder either on your PC or on a network drive for data
storage.
You don't necessarily need your own database server. It is also possible to install
the databasemanagement system on the PC where your software is installed.

l If you know that the new database is going to become very large, you should
make sure in advance that there is enough free storage capacity available on your
servers.

l To be able to set up a database which requires an SQL authentication, you will
have to utilize a user name and password that are both already known in the
DatabaseManagement System (DBMS). If they aren't, you will receive an error
message and won't be able set up the database. In this case, ask the DBMS
administrator for help.

(1) Selecting a database server

Database Server
Enter the name of the database server in theDatabase Server field. If you have
already set up a database on this server from your PC, you will find the required server
in the picklist.
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If it's an SQL server, click alternatively the button with the three points. Select the
database server in theSelect Servers dialog box.
The name of the database server is, by default, <Name of the PC>\OSIS_
MSSQLSRV.
If the SQL server has been installed on the PC onwhich your software also runs, the
name of the database server contains the add-on "(local)".

If you want to work using Oracle, click on the wordsMicrosoft SQL Server you can find
in the text above theDatabase Server field. In theOptions dialog box, select the
Oracle entry from theDatabase system list.

User Authentication
You need to prove that you have permission to set up a database before you are
allowed to. You can do so in theUser Authentication group.

In the Type list, choose theSingle SignOn entry if you are logged on with your user
name to the PC which runs the software. The current log on data for theMS-Windows
operating systemwill also be used for logging on to the database server. In this case,
you will neither need to enter a password nor a user name.
For Single SignOn authentication, there needs to be a user profile set up for you on
theMS-Windows operating system. You also need to be registered under this user
profile in the databasemanagement system.

Windows Login
If you want to use the log-on data with which you are logged on to theMS-Windows
operating system also for logging-on to the database, select theWindows Login entry
in the Type list. As opposed toSingle SignOn authentication, you need to explicitly
enter your user name, password and domain.

This authentication allows you to set up a new database from a computer on which
you are not logged on with your user name.

ForWindows Login authentication, there needs to be a user profile set up for you on
theMS-Windows operating system. You also need to be registered under this user
profile in the databasemanagement system.

SQL Authentication
Select theSQLAuthentication entry from the Type list if you want to use log on data
specific to the database. In this case, you need to enter your user name and password
again each time that you want to change anything in the database. The user name and
password will be assigned by the database administrator within the database
management system, e.g., on an SQL server.

For theSQLAuthentication option, there needs to be a user profile set up for you on
the databasemanagement system. In this case, the log on data are completely
independent of your MS-Windows log on data.

Note: This type of authentication is necessary if you intend to also publish your
database in the Internet at a later date.

OLYMPUS Stream Database User Manual 82



4.  Administrating the database
4.2.   Setting up a new database

(2) Entering the database name

Specifying the database name
Enter a name for the new database in theDatabase Name field. The namemust not
be longer than 20 characters andmust not contain any spaces or special characters.

Specifying the standard database
If the new database is to become your standard database, select theUse as standard
database check box. This optionmakes sense when youmostly work with the same
database.

Later on you can then use the Tools > Options > Database > Standard database
command to specify that the standard database will be automatically opened
whenever you start your software.

Specifying the document storage path
When you set up a new database, you specify where the database files and the
images, (and other documents) are to be saved. The actual database files, such as the
database structure and the entries from the individual database fields, always lie in the
database server. The images and documents to be inserted into the database take up
significantlymore storage capacity than the database files. For this reason, define a
separate storage location for images and documents.

Enter the directory in which the documents are to be stored. To do this, click the button
with three points, then browse to the required directory.

Please pay attention to the information that follows, before you decide at which
location you want to have the database's documents saved.When, for example, you
choose a local directory on your own PC that will have the disadvantage that other
users of the database will not have access to these documents. You should therefore
only choose this possibility if you are the only user of this database. In all other cases,
you should choose a directory to which the other users of this database also have
access (provided they are authorized to do this).

Note: Where you decide which location you're going to choose for saving your
database's documents, the question of data backup plays an important role. To have
your database with all of its documents regularly saved, make sure that both the
database server, and the server on which the documents are stored, are incorporated
in an automatic data back-up process (e.g., every night).

Entering the description of the database
Enter a descriptive text for the new database (optional). This text will later be displayed
in theOpenDatabase dialog box (if you use theUse database connection file
connectionmode). The descriptive text helps users to recognize which database it is
(in case they have not set it up themselves).

(3) Selecting a database template

When setting up a new database, you can either base it on a database template or
define the database structure from scratch. A database template already contains a
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defined database structure. It may possibly also contain documents that you can
incorporate in your database aswell.
If you have a suitable database template, it makes sense to use it. Then you won't
need to set up the database structure anew. A template has the file format DBE. This
file extension stands for database export file.

Note: Your software will have been supplied with some database templates. When
your software was installed, these will have been installed in the following directory:
..\<Directory for saving the application program data>\Olympus\OSIS\<name of the
software>\Database\DBE.
The exact name of the directory for saving application data depends on your operating
system. For theMS-Windows 10 operating system, for example, the directory is called
..\ProgramData in English.

Using a database template
Select the template you want to use. To do so, click the button with the three points,
located at the right side of the Template File Path field, then browse to the directory
you want to use.
A database template has the file extension DBE.

Select theCreate an empty database option if you only want to adopt the database
structure from the database template, and no documents.
The database structure includes record types and the definition of the database's
hierarchy. You can findmore information on the database's structure here.

Select the Import also records and documents (if available) option if, as well as the
database structure, you want to also adopt documents in your new database.
If search templates have been defined in the database template these search
templates are also imported when you choose this option.
When you open a database that has been set up with the template which is by default
provided, e.g., the search template Imageswill be available. This search template
contains a good preselection of database fields that will enable you to search for
images.

Using no database template
Select theCreate an empty database option when you want to set up a database that
doesn't yet have a structure, or when no DBE file is available. In this case, when you
open the new database for the first time, you will have to begin by defining the
database structure, before you can start inserting documents. This possibility is
especially suitable for experienced users.

Note: Because the database views are closely connected with the predefined
database structure, you should keep the predefined database structure. You can only
work well in theDatabase tool window if you do it like this.

(4) Setting up a consolidated record and database

The last of theNew Databasewizard's dialog boxes, oncemore lists all of the settings
you've chosen in the summary report. Check the options for the new database.
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If you want to correct a setting, click the underlined terms. For example, click the term
Database Name, if you want to change the name you've entered, again.

When you change a setting, your software jumps back to theNew Databasewizard's
corresponding dialog box.

Setting up a database
Click the Finish button to create the database.
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4.3. Defining the database structure
Use theDatabase > Administration > Define Database Structure... command to
specify the structure for the active database.

Note: When you want to make changes in a database's database structure, the
databasemust have been opened exclusively.

What is a database structure?
You can insert very different types of data into your database. Examples for record
types are Folder or Image. When you define the database structure, you specify which
data you can insert under specific record types. In this way, you can e.g., define a
hierarchic database structure, in which you can only insert data under a record of the
type Folder.

Please note: Define the database structure when you set the database up, and the
database still doesn't contain any documents. You should only change an existing
database's structure in exceptional cases.

Predefined database structure
When your database is based on the provided database template, once you have set
up the database, the database structure will already be defined. Because the
database views are closely connected with the predefined database structure, you
should keep the predefined database structure. You can only work well in the
Database tool window if you do it like this.
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Description of dialog box

(1) Loading or saving a database template
(2) Viewing the current database structure
(3) Changing the database structure
(4) Defining record types
(5) Adopting a database structure for the current database

(1) Loading or saving a database template
TheDefine Database Structure dialog box, always shows you the structure of the
current database. TheName field therefore always shows the name of the current
database when the dialog box is opened.

Loading a database structure from a template
You can load the database structure of a database that already exists, as a
comparison. To do so, click this button to open theSelect Database Template File
dialog box. A database template has the file extension DBE.

The database structure of the comparison database, is now shown in the dialog box.
In theName list, select your database to view the current database's structure again,
in the dialog box.

Please note:
The database template you've loaded can contain record types that have not been
defined in your database.When you want to adopt such a database template, you
have to click theDefine Record Types... button and set up the record types in your
database.
When the two database structures differ greatly, you can better select the database
template immediately, when you set up a new database.

Saving a database structure as a template
Click this button to set up a new database template. Use this possibility when you want
to use the database structure as a template for other databases.
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A database template can contain a great variety of information.When you save a
database template from theDefine Database Structure dialog box, the database
template will only contain the database structure. If you want to adopt additional
information from the current database in the new database template, use the
Database > Import/Export > Export Database... command.

(2) Viewing the current database structure
In theDatabase structure group, the database's current structure will be shown on the
left. In a tree view, you can see which record types can be arranged under one
another. This display will be automatically updated, as soon as you change something
in the database structure.

Structure of the database template provided
Example: The database template that is provided will be described inmore detail in
what follows.

If you adopt the predefined database structure, only recordswith theProject record
type will lie on the topmost database level (1). These records are database folders
which contain all of the data belonging to one project. Because a separate record type
was defined for projects, projects have their own database fields which only contain
information relevant to the entire project. All projects in the database will be shown in
one of the database views in theDatabase tool window. You also use this Project
View to add or edit projects.

Below the project you can only insert a record of the record typeSample (2). These
records are also database folders, but they have other database fields defined as
those for projects. There is also a database view just for samples.

The documents are added to a sample folder (3). Here, documents refer to images,
charts, workbooks, reports and other documents.
Records cannot be inserted into the database below the documents. So, the database
contains three hierarchy levels in total.

(3) Changing the database structure
TheRecord type list, lists all database types that have been defined in the current
database. Additionally, you'll also find theDatabase entry.

First, select theDatabase entry from the list, or select it in the preview of the database
structure, on the left, in the dialog box. TheDatabase entry stands for the topmost
hierarchy level in every database. In theAccept as child record list, you can now see
which record types can be directly inserted into the topmost hierarchy level. The check
box in front of every record type that is allowed, has been selected.
Check the setting and select or clear the required check box. You can, e.g., specify
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that in the topmost hierarchy, only structured record types, that are indicated by a
folder icon, can be inserted.

Then select, one after the other, every record type from theRecord type list, and
specify which records are allowed to be inserted below these record types. You can,
e.g., specify that workbooks and charts can be inserted under images. This will make it
possible, e.g., to storemeasurement results under images.

Note: When your database works according to the database template you were
provided with, amaximumof three hierarchy levels are possible.

(4) Defining record types
Click theDefine Record Types button to define new structuring record types.

(5) Adopting a database structure for the current database
Click theOK button to adopt the defined database structure for the current database.

Please note the following points:

l The new database structure can't be effective until the next time the database is
opened.
Use theDatabase > Close command. Closing the database window alone isn't
sufficient to close the database. The next time you open the database, the new
database structure will be effective.

l Data that is already in the database won't be changed by a new database
structure.
For example: You have up till now, inserted images under images in your
database. You can forbid the insertion of data under images, in the new database
structure. The insertion of images under images is now no longer possible.
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4.4. Record type

4.4.1. What is a record type?
You can insert very different types of data into your database.
You can insert all of the document types that you create in your software, or can load
into it, e.g., images or diagrams. Aswell as that, you can also insert structuring records
that aren't referenced to a document. Or, you can insert any other file that has already
been saved on a datamedium.
All of these different sorts of data have different record types. AnMS-Word document
has, e.g., the record type File, an image has the record type Image.

Properties of record types
Numerous database fields are only relevant for certain record types. For this reason,
database fields are consolidated into field tables. Every record type can be assigned a
variety of field tables.

Example: There are numerous database fields that are only relevant for images.
Among these are, e.g., the camera settingswith which the image was acquired. A
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table that containsmeasurement results belongs to the record type "Workbook". For
measurement results, naturally, no camera settings are available. All of the database
fields that contain camera settings are therefore, consolidated into the field table
"Camera fields". This field table is only assigned to the record type for which it makes
sense, namely the record type Image.

Predefined record types
The record types Image,Workbook etc. are predefined. They stand for specific
document types. Your software recognizes a document's record type automatically,
when it is inserted, and therefore, in the insertion dialog box, offers you only the
database fields that you have defined for this document type.

You can't set up any new record type in your database, that is referenced to a
document.

Setting up structuring record types
There are record types that within your database are displayed as a folder icon. A
record type of this category isn't referenced to a document, but instead contains only
the information that is entered in the database fields. In your database, you can define
this category of record type yourself.

Use record types that you've defined yourself, to structure your database.

1. Create, e.g., the record type "Experiment", when you want to have the data in
your database assigned to an experiment.

2. Define a field table with database fields that describe the experiment, and allocate
this field table to the record type "Experiment".

3. Check the database structure. Specify which record types are allowed to be
arranged under the experiment.

4. Insert all of the images and reports that belong to this experiment, under this
record.

You can also create a record type called "Laboratory" depending on how you want to
organize your database. It's also possible to define several structuring record types.

4.4.2. Using record types

Database structure
When you define the database structure, you use record types. You specify how the
different record types are to be hierarchically arranged. In this way, you can e.g.,
specify that you can only insert documents under the record type "Folder".

Record name
The record name is different for every record type.
Every record you insert into your database has a record name. The record name is a
mandatory field that has to be filled out when an insertion ismade. Depending on the
record type, another record namewill be suggested.
For images, for example, the image namewill be suggested by default.
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Database views
Some database fields contain information that is not relevant for all record types. For
example, there are numerous database fields such as [X-resolution] that onlymake
sense where images are concerned. For this reason you can define several database
views for each type of record individually and in this way fade out superfluous
information.

Database views
You can selectively search for specific types of record. In theSearch for group, located
in theDefine Search dialog box, all of the record types that have been defined in the
current database will be listed. In this dialog box, select the check box in front of every
type of record that is to be taken into consideration during the database search.

00094

4.4.3. Define Record Types
Use theDatabase > Administration > Define Record Types... command to specify the
record types for the active database.

Prerequisite: Only the database administrator can use this command.

Note: When you want to make changes in a database's database structure, the
databasemust have been opened exclusively.

Description of dialog box

(1) Record types
(2) Field tables
(3) Creating and deleting record types
(4) Defining fields

(1) Record types

TheRecord types group lists all database types that have been defined in the current
database.

Predefined record types
Some record types are predefined. For instance, every document type that your
software supports has its own record type. Although you can rename these record
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types, you can't delete them.

Record
type Description Selection of the predefined database fields

Workbook

A workbook is a document that
contains one or more results
sheets. As a rule these are
measurement results.

Number of Sheets
Workbook Name

Report

Reports are used to document
results in a standardized form. A
report is anMS-Word document.
You can create one with your
software.

Report Name
Page Count

Image

With your software you acquire a
variety of images types. All of these
image types, e.g., individual
images, Z-stacks, or multi-layer
images, belong to the record type
Image.
Also, all image file formats that your
software can load, e.g., VSI, TIF,
JPG etc., belong to the record type
Image.

Image Fields field table: This field table
contains, e.g., the image name and the number
of layers.

Layer Fields field table: This field table
contains numerous image properties, e.g., bit
depth, the resolution, and the number of
channels. All of these properties apply to one
image level.

Camera Fields field table: This field table
contains the camera settings, at the time of the
image acquisition. These fields will naturally
only be automatically filled out when images
you have acquired with your software are
concerned.

Microscope Fields field table: This field table
contains themicroscope settings at the time of
the image acquisition.

File

You can also insert document types
into your database that are not
supported by your software, e.g.,
MS-Word documents with the file
extension DOC. All of these
documents automatically have the
record type File.

File Fields field table: This field table contains
all of the information on the operating system,
that your database can automatically read out
via a file. That includes, e.g., the file creation
time, the file name, and the file name
extension.
This field table is also available for all other
records linked with documents.

Chart

Your software has its own chart
document in which, e.g.,
measurement results can be
visualized.

Chart Name
Chart Type ID

Sample

When your database is based on
the provided database template, it
will contain one structured record
type, with the nameSample.

Record Fields field table: This field table
contains a variety of common information
which should be saved together with the
sample. For example, the database fields
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Samples are database folders
which can be inserted below
projects. They contain the
documents which are related to the
sample.

[Inspection order] and [Sample ID].

Project

When your database is based on
the provided database template, it
will contain one structured record
type, with the nameProject.
Projects are database folders which
contain all of the data belonging to
one project.

Project fields field table: This field table
contains a variety of common information
which should be saved together with a project.
For example, the database fields [Cost center]
and [Deadline].

<Folder>

When your database is based on
the provided database template, it
will contain one structured record
type, with the name Folder.
This record type is not used in the
database structure of the database
you have been provided with.

Folder Name

All record
types

Record Fields field table: This field table
contains some basic database fields that are
relevant for all record types, e.g., the creation
time of a record, the record name or the record
ID number.
This field table always includes a comment
field of theMemo data type. Use this field to
enter even a very long text.

Self defined record types
There are record types that within your database are displayed as a folder icon. A
record type of this category isn't referenced to a document, but instead contains only
the information that is entered in the database fields. In your database, you can define
this category of record type yourself.

(2) Field tables

The Field tables group lists all database fields that have been defined in the current
database. Every database field in it is assigned to a field table. In this way you can
assign several database fields to a record type simultaneously.

Predefined field tables
Every database already contains a number of predefined field tables. These field
tables are indicated by a small lock icon .

Gaining access to the database fields in the field tables
Click the plus sign in front of the field table, to view the database fields that belong to
this field table.
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Assigning field tables to a record type
Select a record type in theRecord types list. Then select the check box in front of the
field table that you want to assign to this record type.

For example: In your database you have defined the record type "Experiment Type A".
For every project, information on the actual project is to be entered. Additionally,
however, you want to save information on the client, together with information on the
project. In this case, define two field tables "Experiment Type A fields" and "Client
information". Assign both of the field tables to the record type "Experiment Type A".
When you now create an additional record type "Experiment Type B", you can use the
client information oncemore.

The predefined field tables are already assigned to individual record types. This
assignment is permanently preset. You can neither assign a predefined field table to
another record type, nor dispense with the specified assignment.

(3) Creating and deleting record types

Creating a new record type
Click theNew Record Type button to set up a new record type in the current database.
A self-defined record is always a structuring record type, that within the database is
indicated by a folder icon. A record type of this category isn't referenced to a
document, but instead contains only the information that is entered in the database
fields.

Field tables for the new record type
When you set up a new record, a new field table that belongs to this record, will
automatically also be created. The field table has the same name as the newly set up
record type (with the extension "Fields"). So, if you set up a record type "Experiment",
the field table "Experiment Fields" will also be created. This field table already contains
the database field [Experiment Name], that will also be used as the record name.
The automatically created field table, at first contains only one database field.
Subsequently define new database fields for the field table and the new record type.

The "Record Fields" field table will be assigned to every record type. It contains
general database fields, that are valid, irregardless of the record type, for every record.
To these records belong, the record name, the setting up time (i.e. the time a record
was inserted into the database), and also a field for comments.

Deleting a record type
Click theDelete Record Type button to delete a record type that already exists. You
will receive a query whether you want to delete the record type or not.

Note: You can only delete a record type when there is no record at all in the database
that belongs to this record type.

The predefined record types, e.g., Image can't be deleted. You can only rename these
record types, further changes are not possible.
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Renaming a record type
In the list, select the record type you want to rename. Press the [F2] key on your
keyboard. Overwrite the record type's name and click the left mouse button.

(4) Defining fields

Click the Fields... button to open theDefine Fields dialog box. In it, you can define the
new database fields and field tables.
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4.5. Database Fields and Field Tables

4.5.1. Overview

Database fields

What exactly, are database fields?
For every record, information will be saved in a database.Which types of information
these are is specified by the database fields.

For example: Should you wish to save the name of the person who acquired an image
together with the image itself, then you would set up a database field with the name
[Staff member]. Then, when you insert an image into the database, you can enter the
name of the staff member in this field.
Which name you assign to the database field is unimportant in this case, it could be
[User] instead of [Staff member].

Predefined database fields
Before you set up new database fields for your record type, check first whether the
existing database fields are already sufficient, or not. For example, if you wish that
when a record of the new record type is inserted into the database, only details about
its name, its creation time, and a comment, are to be entered, you don't need to define
any new database fields.

Field tables

What exactly, are field tables?
Some database fields contain information that is not relevant for all record types. For
example, there are numerous database fields such as [X-resolution] that onlymake
sense where images are concerned. For this reason, database fields will be
consolidated into field tables. A field table is then, simply a group of database fields.

Properties of field tables
l A field table can contain any number of database fields.
l You can't assign the same name to two database fields. That's to say, the
database field [Comment] can't be defined inmore than one field table, instead
you'll have to assign the [Comment] field to one specific field table.
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l Every database field is assigned to a field table.
l You can use field tables that you've defined yourself, for several record types.

Predefined field tables
Every database already contains a number of predefined field tables. You can view
the predefined field tables in theDefine Fields dialog box.

Predefined field tables can't be deleted. You can, however, add your own database
fields to a predefined field table. To do so, use theDatabase > Administration > Define
Fields dialog box.

Defining field tables
When you set up a new record, a new field table that belongs to this record, will
automatically also be created. The field table has the same name as the newly set up
record type (with the extension "Fields"). So, if you set up a record type "Experiment",
the field table "Experiment Fields" will also be created. This field table already contains
the database field "Experiment Name", that will also be used as the record name.

When you want to set up additional field tables, use theDatabase > Administration >
Define Fields dialog box. From this dialog box, you can also fill the new field table with
database fields.
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4.5.2. Setting up database fields
You can define which ever database fields you want that the database user can fill out,
or must fill out, when he sets up a record in the database.

Example: You want to make it possible to enter the laboratory name aswell, when an
image is inserted.

1. Use theDatabase > Administration > Define Fields... command.
l When you define a database field, you change the database structure. That is
only possible when the database has been opened in the exclusivemode.
When the database hasn't been opened in the exclusivemode, amessage
box, in which you can activate the exclusivemode, will open.

l TheDefine Fields dialog box opens. There, you will find all of the database
fields that are already defined in your database. Every database field it contains
is allocated to a group, and a group of database fields is called a "field table".

2. In theDefine Fields dialog box, select the Image Fields entry from the Field tables
list.
l In the Fields list, all of the database fields that belong to the Image Fields field
table will then be listed. This field table contains database fields that are
especially related to images.

3. Click theNew Field button.
4. In theName field, enter a name for the new database field.

Enter, for example "Laboratory No" if you want the laboratory name to be entered
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and saved for every image.
5. In theData type list, select the Text entry for the new database field.
6. Enter themaximumnumber of characters that can be used in the database field,

in theSize field.
For example, enter "10" when your laboratory name is to bemade up of a
maximumof 10 characters.

7. In theDefault Value group, you determine how the field is to behave when a new
record is inserted.
For example, select the first option and leave the field empty, to define no default
value. The database field will then be empty every time youmake an insertion,
and will have to be filled out.

8. Clear the Input required check box.
This will mean that the field can also remain empty when a record is inserted.

9. Select theEditable check box. Otherwise you will have to define a picklist.
10. Click theOK button to adopt your settings and to return to theDefine Fields dialog

box.
l The new database field will then be displayed in the Fields list.

l The new database field will automatically appear in the insertion dialog box.

11. Close theDefine Fields dialog boxwithOK.
l Youwill then receive the query whether you want to make the changed
database views available to all of the database users, or not.

12. Confirm themessage withYes, if all of the database's users are to be able to see
the new database field in the insertion dialog box.

13. Insert an image into the database.
l The new database field will appear in the Insertion dialog box.
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4.5.3. Defining a dependent picklist
You can define a dependent picklist. With a dependent picklist, in contrast to a
"normal" picklist, the user doesn't see all the entries in the picklist, but only some of the
entries. Which entries appear is determined by the value that is currently selected in a
different picklist, themain picklist.

The definition of a dependent picklist involves the following steps.

Creating a new database field that contains the main picklist

Creating a new database field that contains the dependent picklist

Adjusting the database view
This step is not necessary if the new database fields were defined as mandatory fields.
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Example: You work in the quality control department of a car accessories company.
For all images that are added to the database, you now want additional fields,
[Manufacturer] and [Vehicle Model], to be filled out aswell. So that theVehicle Model
pick list isn't too long, youmake the entries that appear in this pick list dependent on
themanufacturer that is selected in themainManufacturer pick list. Then, if the user
wants to add an image to the database and selects "Audi" as themanufacturer, the
Vehicle Model pick list will only contain Audi models. If the user selects "Mercedes" as
themanufacturer, theVehicle Model pick list will only contain Mercedesmodels.

Prerequisite: You are the database administrator and have opened the database in
which you want to define a dependent picklist in exclusivemode.

Step 1: Creating a new database field that contains the main picklist
1. Use theDatabase > Administration > Define Fields... command.
2. In theDefine Fields dialog box, select the field table you want from the Field tables

list. In the above example, select the Image Fields field table.
3. Click theNew Field button.

l TheNew Field dialog boxwill open.

4. In theName field, enter a name for the new database field. In the above example,
enter "Manufacturer".

5. In theData type list, select the Text entry for the new database field.
6. Enter themaximumnumber of characters that can be used in the database field,

in theSize field.
7. In theOptions group, select the Input required check box to define the field as a

mandatory field.
l This database field will be formatted in bold in the dialog boxeswhen a record
is inserted or edited.

8. Select theEditable andEnable picklist check boxes.
l ThePick list group becomes active. In the right hand side of this group under
theOptions field, you can now make various settingswhich affect the behavior
of the picklist. In the above example, leave these check boxes clear.

9. Click theEdit... button.
l ThePick List dialog box opens.

10. Enter themanufacturer "Audi" in theValue field and click theAdd button.
11. Enter themanufacturer "Mercedes" in theValue field and click theAdd button.
12. Close thePick List dialog boxwithOK.
13. Close theNew Field dialog boxwithOK.

l Now the new database field that contains themain picklist is defined. You will
then see theDefine fields... dialog box again. Proceed to the next step.
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Step 2: Creating a new database field that contains the dependent
picklist

1. If the field table you want isn't already selected: In theDefine Fields dialog box,
select the field table you want from the Field tables list. In the above example,
select the Image Fields field table.

2. Click theNew Field button.
l TheNew Field dialog boxwill open.

3. In theName field, enter a name for the new database field. In the above example,
enter "Vehicle Model".

4. In theData type list, select the Text entry for the new database field.
5. Enter themaximumnumber of characters that can be used in the database field,

in theSize field.
6. In theOptions group, select the Input required check box to define the field as a

mandatory field.
7. Select theEditable andEnable picklist check boxes.
l ThePick list group becomes active. In the right hand side of this group under the
Options field, you can now make various settingswhich affect the behavior of the
picklist.

8. Now select theDependent on other field value check box to create a dependent
picklist. In the above example, leave the other check boxes under theOptions field
clear.

9. Click theEdit... button.
l TheDependent Pick List dialog box opens. In this dialog box, you canmake all
the required settings for the dependent picklist.

10. In theDependent on other field group, select the database field that contains the
main picklist from the Field name field. In the above example, this is the
"Manufacturer" field.
l In theValue of <Name of main database field> field, all the entries that were
defined in themain picklist are now displayed. In the above example, these are
the "Audi" and "Mercedes" entries.

l There is a yellow warning sign next to these entries, indicating that these
entries have not yet been allocated to the entries in the dependent picklist.

11. In thePick list configuration for <Name of dependent database field> group, enter
all entries that should be contained in the dependent picklist in theValue field. In
the above example, enter all the vehicle models, "A1", "A3", "A5", "A-class" and
"S-class" for example. Click theAdd button after each entry.
l The new entries appear in thePick list entries for '...' list. You can still edit and
rearrange them. To do this, use the buttons to the right of this field.

12. Now allocate the entries in the dependent picklist to the entries in themain picklist.
In the above example, specify which vehicle models belong to which
manufacturers. To do this, select themanufacturer "Audi" from theValue of
'Manufacturer' table, and then select the vehicle models "A1", "A3" and "A5" in the
Pick list entries for '...' list. Next, select themanufacturer "Mercedes" and select
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the vehicle models "A-class" and "S-class" from thePicklist entries for '...' list.

l The yellow warning signs in theValue of <Name of main database field>

field are replaced with blue checks . The checks indicate that the allocation
of the entries in themain picklist to the entries in the dependent picklist has
taken place.

13. Close theDependent Pick List dialog boxwithOK.
14. Close theNew Field dialog boxwithOK.
15. Close theDefine Fields dialog boxwithOK.

l Youwill then receive the query whether you want to make the changed
database views available to all of the database users, or not.

16. Click theNo button because the changes should initially only apply for you. You
can transfer the changed view to all users of the database at a later point in time.
To do this, use theAssign Configuration to... command in theCustomize Views
dialog box.
l The dependent picklist has now been defined.

l If you have defined the two new database fields asmandatory fields, as
described above, theywill automatically be displayed in the insertion dialog.

17. As a test, insert an image into the database and checkwhether the entries in the
dependent picklist really do correspond to the value that is currently selected in the
main picklist.
l The new database fields should now be displayed at the very bottom of the
insertion dialog. In the above example, these are the [Manufacturer] and
[Vehicle Model] fields. Select the "Audi" and "Mercedes" entries one after the
other in the [Manufacturer] field and checkwhether the picklist in the [Vehicle
Model] field displays only themodels that you have defined for the
manufacturer that is currently selected.

Step 3: Adjusting the database view
Note: If you did not define the two new database fields asmandatory fields, you now
have to adjust the database view for the insertion dialog. This step is also required if
you want the new database fields to be in a different position in the insertion dialog. To
do so, proceed as follows:

1. Use theDatabase > Views > Customize Views... command.
l TheCustomize Views dialog boxwill open.

2. Select the database view that you want to adjust, in theSelection of views and
record types group. In the above example, select the Insertion Dialog view. The
Image record type is set by default.

3. If the database fields that are now displayed in the Insertion Dialog view weren't
defined asmandatory fields, theywill not be displayed in theSelected fields list
yet. Select them from theAvailable fields list, then click theAdd >> button.
l The database fields you've selected are added to the bottom of theSelected
fields list.
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4. If required, move the new database fields to a different position. To do this, select
the database field in theSelected fields list, and click the button with the arrow .

Note: When changing the position of the database fields, make sure that the new
database fields are displayed in the correct order. The database field that contains the
main picklist must be filled out before the database field that contains the dependent
picklist. In the above example, the [Manufacturer] field must come before the [Vehicle
Model] field in the insertion dialog.

l You can alsomove the database fields to a new group. This new group is then
displayed as a separate tab in the insertion dialog.

5. Close theCustomize Views dialog boxwithOK.
6. As a test, insert an image into the database and check the view in the insertion

dialog.
l The fields you want should now be displayed in the insertion dialog at the
position you defined.

00820 05022014

4.5.4. Dialog box - Define Fields
Use theDatabase > Administration > Define Fields... command to add database fields
to the active database or to change existing ones.

Note: When you want to make changes in a database's database structure, the
databasemust have been opened exclusively. You can findmore information on the
exclusivemode here.

Description of dialog box

(1) Field tables
(2) Database fields
(3) Record name

(1) Field tables

All of the active database's field tables are listed in the Field tables group.
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Which database fields have been assigned to a specific field table?
Click one of the listed field tables. In the Fields table, all of the database fields will then
be listed which have been assigned to this field table.

 New Field Table
Click theNew Field Table button to set up a new field table in the current database.
Initially, a new field table will contain no database fields. You subsequently define new
database fields for this field table.

 Delete Field Table
Click theDelete Field Table button to delete a field table that already exists. You will be
asked whether you want to delete the field table or not.

Note: If you delete a field table, you will automatically also delete all of the database
fields that were assigned to this field table. You will also lose all of the information that
was earlier entered in these database fields.

Some field tables can't be deleted. These field tables contain database fields that the
database structure requires ("System fields"). You can only rename these field tables,
further changes are not possible.

Renaming field tables
In the list, select the field table you would like to rename. Press the [F2] key on your
keyboard. Overwrite the field table's name and click the left mouse button.

Translating field tables
The database can be used by different users and also from different PCs. You can
simplify the use of the database for users who speak different languages by translating
the field tables.

(2) Database fields

In the Fields table, all of the database fields will then be listed which have been
assigned to the active field table. You can findmore information on database fields and
field tables here.

Setting up a new database field
Click theNew Field button to set up a new database field in the active field table. The
New Field dialog box opens.

Editing an existing database field
Click theEdit Field button to change the properties of an existing database field. The
Edit Field dialog box opens.

Deleting a database field
Click theDelete Field button to delete am existing database field. You will receive a
query whether you want to delete the database field or not.
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Note: When you delete database fields, you will also lose all of the information that
was earlier entered in these database fields.

Translating the names of database fields
The database can be used by different users and also from different PCs. You can
simplify the use of the database for users who speak different languages by translating
the database fields.

(3) Record name

What exactly is the record name?
Every new record that is added to the database needs to have the [Record Name]
database field completed. This database field is automatically defined in every
database that you set up with your software.
The [Record name] database field will automatically be completed when any record is
inserted. It differs from other database fields as nothing is explicitly entered into this
field. Instead of entering new information, the content of another database field is
used.

You can, e.g., where an image is concerned, always use the image name as the
record name.

Specifying the record name
Click theRecord Name... button to view which database field will be automatically
used as the record name. For a database's different record types, different database
fields are available, since a database field such as [Image Name] can never be
available for the record typeWorkbook.

In theRecord Name dialog box, you can also change the default settings.
5627 14032012

4.5.5. Dialog box - Dependent Pick List
Use theDependent Pick List dialog box to set up a list of possible entries for a
database field, and to edit them.

The entries available in the dependent picklist are "filtered" according to the current
value in themain picklist.

To open the dialog box, select theDependent on other field value check box in the
New Field or Edit Field dialog box and click theEdit... button.
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Description of the function groups
(1) Dependent on other field
(2) Pick list configuration for <Name of the dependent database field>
(3) Edit dependent pick list

(1) Dependent on other field

Select the database field that contains themain picklist from the Field name field. Then
all the entries that were defined in themain picklist are displayed in theValue of
<Name of main database field> field.

If these entries have not yet been allocated to the entries in the dependent picklist,
there is a yellow warning sign next to each entry.

If these entries have already been allocated to the entries in the dependent picklist,

there is a blue check next to each entry.

Note: If you select a different database field in the Field name field, the allocation to the
entries in the dependent picklist is lost. If you select a different field in the Field name
field as a test for example, and then switch back to the original field, you have to do the
allocation to the entries in the dependent picklist again. As a precaution, you receive
an error message when you select a different database field in the Field name field.

(2) Pick list configuration for <Name of the dependent database
field>

Enter all entries that should be contained in the dependent picklist in theValue field.
Click theAdd button after each entry. The new entries appear in thePick list entries for
'...'.
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Note: Allocate all entries in thePick list entries for '...' list to one or more entries in the
main picklist. If you have an entry in thePick list entries for '...' list that is not allocated to
any entry in themain picklist, this unallocated entry will always be shown (for example
every time you add a record to the database).

Then allocate the entries in the dependent picklist to the entries in themain picklist.

To do this, first select an entry in theValue of <Name of main database field> field and
then select all entries in thePick list entries for '...' list that you want to allocate to this
selected entry.

If the dependent picklist is very long, use theSelect All orClear All buttons to select or
deselect all entries in the picklist at once.

Note: TheClear All button doesn't delete any entries from the picklist, it just deselects
them.

(3) Edit dependent pick list

Editing entries
Click theAdd button to add this entry to the picklist.

Click theChange button to have an entry you have selected in the picklist replaced by
the entry in theValue field.

Click theDelete button to remove an entry you have selected from the picklist.

Click theUp button to have the entry you have selected in the list moved up one
position.

Click theDown button to have the entry you have selected in the list moved down one
position.

Sorting entries
Click theSort button to have the entries in the picklist ordered as preset in theSort
group.

Select theAscending option to have entries of the Text data type sorted alphabetically
fromA to Z. Entries of the Integer orDouble data type will be sorted by their
magnitude, with the lowest number at the top of the list. Entries of theDate/Time data
type will be sorted so that the oldest date is at the top of the list, the 01.01.2010 will
come before the 01.01.2020.

Select theDescending option to have entries of the Text data type sorted
alphabetically from Z to A. Entries of the Integer orDouble data type will be sorted by
their magnitude, with the highest number at the top of the list. Entries of theDate/Time
data type will be sorted so that themost recent date is at the top of the list, the
01.01.1998 will come before the 01.01.1923.

Select theAutomatic check box to have new entries immediately sorted according to
the entry that has been selected.

Note: In this case you can no longer manually sort the picklist, since themanual sorting
will immediately be reset as soon as you add another entry to the picklist.
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Exporting and importing a picklist
Click theExport ... button to save the picklist in a file. The file extension for this sort of
file is DPL. The DPL file contains precisely the field values displayed at that moment, in
theEdit Pick List dialog box.
In this way, you can easily use one picklist for several database fields. An example is a
list of employees that can be assigned both to the [Operator] database field, and also
to the [Responsible Person] database field.
You can also use the export function for a picklist to document the specific state of a
picklist. You can then restore the picklist to this state at a later point in time.

Click the Import... button to load a list of field values that you had previously exported,
into thePick List dialog box.
A list of field valuesmust have the file extension DPL. The field valueswill be added to
the entries that are, at that moment, specified in theEdit Pick List dialog box.

Click theDelete List button to delete all of the entries in the picklist. Then no picklist will
any longer be available to you when you insert records.

4889 29012014

4.6. Changing the database view
TheDatabase tool window is divided into several areas. In each of these areas, a
special database view is displayed. In the following, you will find a description of the
procedure for changing a database view.

Note: When you change a database view, these settings are only valid for you.With
other users, the database viewswill not be changed.

4.6.1. Changing the database view
1. Use theDatabase > Views > Customize Views... command.

l TheCustomize Views dialog boxwill open.

2. Select the database view and the record type you want to change, in theSelection
of views and record types group.

3. Make the required changes. You have the possibilities that are given below. Not
every possibility is available for every database view.

l Adding additional database fields to the database view
l Hiding database fields that are present in a database view
l Changing the order in which the database fields are displayed
l Grouping database fields
l Deleting a group
l Changing the group's name

4. To adopt your changes, click theOK button.
l The changed database view will be displayed.

OLYMPUS Stream Database User Manual 105



4.  Administrating the database
4.6.   Changing the database view

4.6.2. Adding additional database fields to the database view
1. Open theCustomize Views dialog box.
2. From theView list, select the database view you want to adjust.
3. When theSelected fields list contains several groups: First, select the group to

which the database field is to be added.

l In the dialog box, a group is indicated by a directory icon (1).
In the example shown, two groups, each with three database fields, are on
display in the database view that has been chosen (2).

4. In theAvailable fields group, specify how the database fields are to be displayed in
theCustomize Views dialog box.
l If your database doesn't have toomany fields, click the Flat View button to have
all of the databases listed, one under the other.

5. Select one or several database fields in theAvailable fields list.
l TheSelect >> button will become active.

6. Click theSelect >> button.
l The database fields you've selected are added to the bottom of theSelected
fields list.

7. Should you want to, you canmove the database fields you've added, by
Drag&Drop, to another position within the group.

00319 07072011

4.6.3. Dialog box - Customize Views
Note: A change youmake in the view configuration is only valid for you.With other
users, the database viewswill not be changed.
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Description of dialog box

(1) Selecting the view and record type
(2) Assigning database fields to a view
(3) Grouping database fields in a view
(4) Assigning the configuration

(1) Selecting the view and record type

From theView list, select the database view you want to configure. In theCustomize
Views dialog box, you determine which database fields are to be displayed in this view.

Some database fields contain information that is not relevant for all record types. For
example, there are numerous database fields such as [X-resolution] that onlymake
sense where images are concerned. For this reason you can define several views for
each type of record individually and, in this way, hide superfluous information. From
theRecord type list, select the type of record for which you want to customize the view
you've selected.

(2) Assigning database fields to a view

Available database fields
In theAvailable fields list, you can find all of the database fields that are available in the
selected view for the selected record type.

Assigning database fields to the chosen view
Select one or more database fields and click theSelect >> button to have them
displayed in the database view you have selected.
Please note that in the database gallery and in the Project Header View only one
single database field can be displayed. In this case, the current database field will be
automatically replaced by the database field you have selected.

Selected database fields
TheSelected fields list contains all of the database fields that will be displayed in the
selected view.
You can change the order in which the fields appear in the view by selecting a field and
shifting it upwards or downwardswith the arrow buttons
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.

Select a database field in theSelected fields list and click the << Remove button to
remove it from this view.
The database field and the corresponding field contents will be retained. Theywill
simply be no longer displayed in the database view.

Returning database views to their default settings
Click theReset View button to return the database view you have selected to its
default settings.

Click theReset All Views button to return all of the database views to their default
settings.
This button is only available if you used theCustomize Views... command from the
Database > Viewsmenu to open the dialog box. If you open the dialog box from one of
the context menus, this button is grayed. You cannot use it then.

The database views determine the appearance of theDatabase tool window. These
are completely independent of the user interface's layout. TheView > Layout > Reset
Current Layout command has, therefore, no influence over the database view.

(3) Grouping database fields in a view

Grouping database fields
In some database views, e.g., the Record Details View, a large number of database
fieldsmaywell be displayed. Use the possibility of grouping database fields to present
the informationmore clearly in a number of groups. You can later on, in the database
window, reduce the content of a group to just the group's name and in this way fade
out information that doesn't interest you at themoment.
Click the small arrow next to the group name to reduce the group's size. Click this
arrow to expand the group.

On the left, you see one of the info views, which contains two groups of database
fields. On the left, the upper group has been reduced, so that only the group's name
will be displayed.

To group database fields, set up a number of folders in theSelected fields list. All of the
database fields under a folder will later be displayed in their own group in the
Database tool window. This group gets its name from the name the folder has in the
Selected fields list.
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Setting up a new group
Click theNew Group button to set up a new group folder in theSelected fields list. You
can give the group folder its name directly when you set it up. You can change this
name subsequently whenever you want to.
Tomove database fields into a group folder, youmust first select the group folder in
theSelected fields list. Then you select the database fields in theAvailable fields list,
and click theAdd >> button.Within theSelected fields list you can alter the allocation
of the database fields to the group folders however you want to byDrag&Drop. Simply
drag a database field with your left mouse button depressed, from one group folder
into another.

Deleting a group
Select a group folder and click theDelete Group Header button to delete the selected
group from theSelected fields list. All of the database fields belonging to the deleted
group will bemoved into theAvailable fields list and will, therefore, no longer be
displayed in the view you have selected.

Changing the order of the displayed groups
You can change the order in which the groups appear in the view by selecting a group
folder and shifting it upwards or downwardswith the arrow buttons .

(4) Assigning the configuration

TheAssign Configuration to... button is only available for database
administrators. With it, they can have the changes they havemade to the database
views transferred to all users of the database.

Note: This button is only available if you have used theDatabase > Views >
Customize Views...menu command to open the dialog box. If you open the dialog box
via one of the context menus, the button is displayed in gray.

5630

4.7. Exclusive Mode
To be able to carry out changes in the database structure, you have to open a
database in the ExclusiveMode.

To be able to switch the exclusivemode on, youmust possess either the
"Administrator" or the "Power User" user rights.

What exactly, is the Exclusive Mode?
At any given time, only one user can be in thismode for a given database. Other users
of the database can't have opened the database during the ExclusiveMode, and also
can't open it.

Why use the Exclusive Mode?
The ExclusiveMode ensures that you canmake changes that become necessary in
the database, in the certain knowledge that no other user will be able to work with the
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database while you are doing this. This ensures that no loss of data can possibly take
place.

Opening a database in the Exclusive Mode
Should you want to open a database in the ExclusiveMode, onto which other users
are already logged on, you will first have to request them to let you use the Exclusive
Mode. Thismeans that the other users will receive a request to close this database.
Also users who want to open this database while the ExclusiveMode, has been
requested or activated, will receive the demand to close the database again. You can
only open the database in exclusivemode once all other users have closed the
database.

Switching on the Exclusive Mode
Open the required database. Select one of these possibilities to switch on the
ExclusiveMode:

1. Open theManage ExclusiveMode dialog box to provide yourself with an overview
of how many users are currently logged onto the database. To do so, use the
Database > Administration > Manage ExclusiveMode... command.
If you are the only user, theActivate button will be active. Click this button.

2. Use theDatabase > Administration > ExclusiveMode command.
3. Select one of the commands in theDatabase > Administrationmenu, that

requests the ExclusiveMode. A correspondingmessage boxwill then be
displayed, in which you can switch on the ExclusiveMode.
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4.8. Database user rights

4.8.1. Overview
You can define user rights for your database.

Note: What follows only refers to user rights for databases. Irrespectively of this, your
software also has its own user rights. You define these when you use theUser
Rights... command in the Toolsmenu. A database's user management is completely
independent from themanagement of user rights for your software.

What purpose do user rights serve?
Use the user rights to, for example, limit the access to data in the database to a specific
circle of people.

How do I manage user rights?
Use theDatabase > Administration > User Accounts... command to register new
users with the database. A user profile is always also linked to a user role. Which rights
the user has in the database is specified in this role.
Users can be combined into groups. A user group is always linked to a permission set.

OLYMPUS Stream Database User Manual 110



4.  Administrating the database
4.8.   Database user rights

Which user roles are defined?
Every database user can assume one or more roles, e.g.,Administrator or Power
User. Each of these roles can in each case use different database functions. The
functions that are linked to each role are predefined and cannot be changed.

Specifying access rights for user groups
When you set up a new user group you will automatically also set up a so-called
permission set with exactly the same name as the user group.When the user later on,
for example, inserts a document into the database, he will have to select a permission
set to do this. When he does so, theEveryone permission set will always be
suggested, and, when available, the permission set of the group he is amember of.

When the user selects theEveryone permission set, all of the database's users are
allowed to view the document. When he instead, uses his user group's permission set,
only themembers of his user group are allowed to view the document. Members of
other user groupswill, in this case, not see the document, and that neither in the
gallery, nor when search results are displayed. The selection of the permission set
during the insertion of documents, therefore controls which people will be allowed to
view the document.

You not only select a permission set for each document that you insert into the
database, you also do so for every structuring record (e.g., projects, samples,
institutions, departments etc.), that you set up. Users of the software who do not
belong to your user group will then not be able to see all of the folders, including all of
the documents that are in them.

Note: Theoretically you can, for every single document, also precisely control, who is
allowed to open, view, change or delete, this record. To do this, select the record,
open the context menu and select thePermissions... entry. However, we recommend
that you only work with permission sets, since this simplifies what you do, and is easier
to control.
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4.8.2. Setting up a new database user
Let's assume that your company has employed a new employee who is to have
access to the database. Before this person can open the database, the database
administrator must register the new employee in the database.

1. Use theDatabase > Administration > User Accounts... command.
l In a newly set up database, there will always be at least one user, namely the
person who set it up. Additionally, theEveryone user group will always be set
up.

l In theUser Accounts dialog box. all of the existing users and user groupswill
be listed.

Adding users
2. Click theAddUser... button.

l TheAddUser dialog box opens.
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3. Click theBrowse... button.
l TheBrowse for Database Server Users dialog box opens. Here, all of the
users who are registered in the DBMS are listed. Should you be the DBMS
administrator, you can also register a new user in the DBMS there. To do this,
click theNew... button.

l Should the user you want not be listed there, and you are not the DBMS
administrator, apply to the DBMS administrator.

l If you know which users are registered with the DBMS (e.g., because the
DBMS administrator has given you a list), enter the user's name in theUser
name field, then click theNext > button.
Then continue with the "Assigning user properties" step.

4. In theBrowse for Database Server Users dialog box, select the required user,
then click theOK button.
l Youwill then see theAddUser dialog box oncemore.

5. If you want to, enter a description of the new user in theAddUser dialog box, then
click theNext > button.
This description appears in theUser Accounts dialog box, and can help you to
keep track of all of the users.
l TheUser Properties dialog boxwill appear. In it, you will see that the new user
has been automatically assigned to theEveryone user group.

Assigning user properties
6. Should you want to, assign the user to additional user groups, then click theNext

> button.
l The next dialog box shows the possible roles the new user can be assigned. A
user has to be assigned at least one role. This determineswhich rights he has
to view certain database records.

7. Select the role the user is to be assigned. You can also assign a user several
roles.

8. If you assign the user more than one role, select thePrompt for role selection at
login check box. Only in this case will the user be asked which role he is going to
use when he logs on to the database.
If this check box hasn't been selected, the user can't choose his role, but always
starts with the role that has been defined as the default role. Only the
administrator can assign this user another default role.

9. Click the Finish button.
l TheUser Accounts dialog box appears again. The new user is now shown in
the user list.

10. If required, addmore users to the database, or close the dialog boxwithOK.

Informing the user
11. Then inform the user.

l Inform the newly added user that he now has the right to open this database.

l Send him a link to the DBC file.
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l Should you have newly set up the user in the DBMS, inform himwhich user
name and which password (including the case sensitivity used) he is to use
when he logs on to the database (when it's a database with SQL
authentication).
Whether the user will be able to change this password later on depends on the
options offered by the DBMS. In certain cases, passwords can only be
changed by the DBMS administrator.

4.8.3. Setting up a new database user in the database and the
DBMS simultaneously

If you are yourself the DBMS administrator, and have logged on to the database with
the administrator password, you can set up a new database user in the DBMS via the
software.

1. Use theDatabase > Administration > User Accounts... command.

Adding users
2. Click theAddUser... button.
3. Click theBrowse... button.

l TheBrowse for Database Instance Users dialog box appears. The required
user does not appear in the List of Users field.

4. Click theNew... button.
l TheAddNew Database Server User dialog box opens.

5. Enter the user name and assign a password for him. Select the authentication
SQLAuthentication.

6. Click theOK button.
l The newly set up user will then appear in the user list.

4.8.4. Setting up and editing a user group in a database

Setting up a new user group in a database
1. Use theDatabase > Administration > User Accounts... command.

l TheUser Accounts dialog box opens.

2. Click theAddGroup... button.
l TheNew User Group dialog box opens.

3. On theGeneral tab, enter the name of the user group and, if required, a
description.

4. Go to theMembers tab. Since the new user group doesn't yet have anymembers,
click theAdd... button.

5. In theAddUser dialog box, select a user who is to belong to the new user group,
then click theAdd button.
l The user you've added will appear on theMembers tab.
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6. If required, click theAdd button again, then select another user who is to belong to
the new user group in theAddUser dialog box.

Note: Since you are the database administrator, we recommend that you also add
yourself to all of the user groups you set up. Only in this way can you be certain that
you'll always be shown all of the records that the database contains.

7. Click theOK button to finalize the definition of the new user group, and to close the
User Accounts dialog box.

Changing the members of a user group at a later point in time
1. Use theDatabase > Administration > User Accounts... command.
2. Select the user group you want to change, then click theProperties... button.
3. Switch to theGroupMembership tab andmake the required changes there.
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4.9. Archiving documents
To archive them, you canmove images and documents to another document
directory.

Example: At the end of the year, all of the records that were inserted into the database
during the year 2010, are to bemoved to a document directory of their own.

Defining a suitable search definition
1. Use theDatabase > Define Search... command.

l TheDefine Search dialog box opens.

2. Click theSelect All button to find all of the records, irrespective of their record type.
3. Define the following search condition in theConditions group.

[Insertion date] >= '01.01.2010' AND [Insertion date] < '01.01.2011'
l Now, all of the records that were inserted into the database during the year
2010 will be found.

4. Save the search definition. To do so, click theSave Search Definition button in the
Define Search dialog box.
l TheSave Search Definition As dialog box opens.

5. Enter "2010" in theName field.
6. Close the open dialog boxes.

Selecting a search definition for the moving of files
7. Use theDatabase > Administration > Move Files... command.

l TheMove Files dialog box opens.

8. Select the From saved query '2010' in the Files to bemoved' list.
l In theDescription field, you'll now see the search condition. Checkwhether the
search condition is correct.
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Selecting a new document directory

9. Click theSettings... button.
l TheSettings > Document Storage Type > File System dialog box opens.

10. Click theNew Volume button to integrate a new document directory into the
database.
l TheNew Volume dialog box opens.

11. Enter "2010" in theDescription field.
12. Set up the path name for the document directory.

When you do this, please note that the document directory has to be available to
all users when you want to continue to work with the database in the way you're
used to.

13. Select theArchive entry in theMedia Type list. By doing this, you indicate that the
new document directory "2010" has been finalized. No additional records can then
be inserted into this document directory anymore.

14. Close all open dialog boxeswithOK.
l Your software will thenmove all files that are found with the selected search
definition, into the document directory "2010".

l When themovement of these files has been successfully completed, you'll
receive amessage.

l Even when the records have beenmoved, you can still work with these records
as usual within the database. The prerequisite for this is, of course, that the
new document directory is available to all users.

l You can now, for example, copy this directory onto a DVD, and by doing so, set
up a backup copy.

00103

4.10. Delete Database
Use theDatabase > Administration > Delete Database... command to delete the
active database.

Please note: You cannot restore a database once you have deleted it. Therefore,
you should only delete databaseswhen you're absolutely certain you won't need the
data anymore. You will receive a warningmessage before the database is deleted.

Creating a data backup before the deletion
In certain cases, it might make sense to export the database with all of its documents
into a Database Export File (DBE file), before you delete it. Then you can create a new
database on the basis of this DBE file at any time you want to.

Before you can delete a database
l Before a database can be deleted it must have been closed.
l Should several users have access to this database, you will also have tomake
certain that none of these users has opened the database at the time you delete it.
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4.10.   Delete Database

Should you want to delete a database that another user still has open, you will
receive an error message, and the deletion processwill be canceled.

l Should not know for certain whether another user has opened the database you
want to delete, you can check this out before youmake the deletion. To do so,
open the database you want to delete, then open theManage ExclusiveMode
dialog box, by using theDatabase > Administration > Manage ExclusiveMode
command.

Delete Database
1. Make certain that the database you want to delete has been closed by yourself

and by all other users.
2. Use theDatabase > Administration > Delete Database... command.

l TheDelete Database dialog box opens.

3. In theDatabase connection file group, select the DBC file of the database you
want to delete. Should the DBC file not be contained in the picklist, click the [...]
button, then browse to the location where it has been stored. Don't proceed until
you have oncemoremade certain that the correct DBC file has been selected.

4. Should you no longer have the DBC file, you will first have to alter the connection
mode, before you can delete the database. To do so, proceed as follows:
Click theOptions... button, then select theEnter connection datamanually
connectionmode in theOptions dialog box.
Close the dialog boxwithOK.
l Youwill then oncemore see theDelete Database dialog box. The upper part of
this dialog boxwill have changed. Now, theDatabase group will be on display.
Enter the connection data of the database you want to delete there.

5. Should the database that is to be deleted have an SQL authentication, you will
need to enter your name and the password.Where a database withWindows
Authentication is concerned, you will not need tomake an entry in theUser group.

6. Click theOK button.
l Youwill receive a warningmessage, whether you really want to delete the
selected database.

7. Check once again whether the database that has been suggested really is the one
you want to delete. If this is so, click theYes button.
l The database will then be irrevocably deleted.

l TheDBC file will also be automatically deleted.

l Should the database that is to be deleted be of the File System document
storage type, all of the files that are in the specified document directory will be
deleted. The directory itself can't be automatically deleted, so please delete it in
MS-WindowsExplorer.

l Should the database you want to delete have theSecure File Repository
document storage type, the data on the server for the Secure File Repository
will be deleted with a time delay (approx. 20minutes).
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